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ВВЕДЕНИЕ 

На первый взгляд Microsoft Project кажется еще одним приложением 
семейства Microsoft Office с панелью инструментов, как в Word, таблицами и 
графиками, как в Excel. Но чем глубже вы будете осваивать Microsoft Project, 
тем больше отличий вы заметите. 

Одно из ключевых отличий состоит в узкой области применения 
программы. Если другие приложения семейства Microsoft Office 
ориентированы на широкую область применения и содержат самые разные 
функции, то программа MS Project предназначена исключительно для 
управления проектами. 

Другое важное отличие заключается в том, что с MS Project 
невозможно работать, не обладая теоретическими знаниями в области 
управления проектами и не зная особенностей этой программы. Любой 
пользователь может открыть Word и подготовить документ, не читая 
предварительно книгу размером с ту, что находится в ваших руках. Конечно, 
этот пользователь не будет применять команды стилевого оформления, 
возможно, он не сумеет вставить в документ номера страниц и т. п., но 
документ будет готов к распечатке и им можно будет воспользоваться. Если 
же вы откроете MS Project и попробуете создать план проекта, то без 
специальных знаний вы не сможете получить план, пригодный для 
реализации проекта. 

Этот курс разделен на три части. В первой части вы познакомитесь с 
интерфейсом программы, чтобы узнать возможности инструмента, с которым 
вам в дальнейшем придется работать. При этом не требуется теоретических 
знаний в области управления проектами: вы будете осваивать принципы 
работы с таблицами и диаграммами, учиться вводить, редактировать, 
сортировать, группировать и фильтровать данные. 

Во второй части мы перейдем к созданию проектного плана. В этой 
части вы будете создавать собственный план проекта и одновременно с 
практикой планирования будете изучать теорию управления проектами. Вы 
узнаете о том, как определять состав работ, как распределять ресурсы, 
планировать затраты и риски, как распространять файл на утверждение и 
сравнивать версии проектов. 

В третьей части вы научитесь отслеживать проект, то есть 
контролировать выполнение плана проекта и вносить в план необходимые 
изменения по ходу работ. Вы узнаете, как сохранить исходный план проекта, 
раздать задачи сотрудникам, организовать сбор данных о ходе работ, 
проанализировать собранные данные и подготовить отчеты. 

 
 
 
 



 7 

ОСНОВНЫЕ ТЕРМИНЫ 

Проект состоит из задач, то есть активностей, направленных на 
достижение определенного результата. Чтобы задача могла быть выполнена, 
на нее выделяются ресурсы — материальные (оборудование) и рабочие 
(сотрудники). Выделение ресурса на задачу называется назначением, и у 
задачи может быть неограниченное число назначений. 

Задачи могут объединяться в группы (или фазы), и задача, 
объединяющая другие, называется суммарной. Завершающие задачи, то есть 
задачи, выполнение которых приводит к достижению важного проектного 
результата или завершает фазу, называются вехами. 

Задача имеет длительность, то есть время, необходимое на ее 
выполнение. Кроме того, задача характеризуется объемом трудозатрат 
(объемом работ) и затратами (или стоимостью), необходимыми для ее 
выполнения. 

В плане проекта задачи связаны с помощью зависимостей, 
определяющих порядок выполнения задач относительно друг друга. 
Длительность проекта складывается из промежутков времени от начала 
самой ранней задачи до окончания наиболее поздней с учетом зависимостей 
между задачами. Если при увеличении длительности задачи увеличивается 
длительность всего проекта, задача называется критической. 

Если вы встретите в процессе чтения первой части другие термины, 
вы можете найти их объяснения с помощью алфавитного указателя, 
показанного на рис. 1.1 

 

 
 
Рис. 1.1. Ссылки на важные разделы справочной системы MS Project 
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Лабораторная работа № 1 

ОСНОВНЫЕ ЭЛЕМЕНТЫ ИНТЕРФЕЙСА MS PROJECT 

Задание для выполнения работы 

1. Настройте MS Project таким образом, чтобы при загрузке 
отображались панели Task Pane (Область задач) и Project Guide 
(Консультант), а панель View Bar (Панель представлений) была скрыта. 
Сохраните эти настройки так, чтобы они использовались для всех вновь 
создаваемых файлов.  

Контрольные вопросы 

1. Как настраивается MS Project и какие параметры определяют 
отображение данных в его интерфейсе.  

2. Как сохранять настройки для использования по умолчанию.  
3. Как отображать и прятать панели Task Pane (Область задач), 

Project Guide (Консультант) и View Bar (Панель представлений), а также для 
чего они предназначены.  

4. Из каких основных элементов состоит интерфейс MS Project. Что 
такое представление.  

5. Как хранятся данные «внутри» файла проекта MS Project (как 
группируется проектная информация)?  

6. Каким образом (с помощью какого элемента интерфейса) 
проектная информация отображается в программе?  

7. Из каких основных элементов состоит интерфейс MS Project?  

1.1. Основные элементы интерфейса 

Окно MS Project (рис. 1.2) содержит следующие элементы: 
• меню;  
• панели инструментов;  
• строка ввода;  
• рабочая область;  
• строка состояния 
Меню, панели инструментов и строка состояния являются 

стандартными элементами программ Windows. 
Настройка меню и панелей инструментов осуществляется щелчком 

правой кнопки мыши на панели инструментов или меню и последующим 
выбором в появившемся контекстном меню пункта Customize (Настройка). 
Убрать или отобразить строку состояния можно в диалоговом окне Options 
(Параметры). Откройте это окно, выбрав команду меню Tools > Options 
(Сервис > Параметры), перейдите на вкладку (View Вид) и установите или 
сбросьте флажок Status bar (Строка состояния). 
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Строка ввода служит для ввода и редактирования значений в ячейках 
таблиц и на диаграммах, аналогично знакомой вам строке формул в Excel. 
Хотя в большинстве случаев выполнять эти действия можно 
непосредственно в диаграммах или таблицах, часто бывает удобнее 
пользоваться строкой ввода. Кроме того, в некоторых случаях строка ввода 
является единственным способом добавления или изменения данных, 
например, если вы сняли флажок Edit directly into cell (Правка прямо в 
ячейке) при настройке параметров редактирования.  

1.1.1. Рабочая область MS Project 

Рабочая область программы требует подробного рассмотрения, 
поскольку методы работы с ней специфичны для MS Project. Рабочая область 
MS Project состоит из панели представлений (View Bar) и собственно 
представлений проектных данных (рис. 1.2). 

 
 

Рис. 1.2. Окно MS Project: 
1 — панель представлений; 2 — окно с выбранным представлением 

Gantt Chart (Диаграмма Ганта) 
 

Панель представлений содержит значки с названиями представлений, 
щелкая на которых можно быстро переключаться между различными 
представлениями. Например, на рис. 1.3 видно, что после щелчка на значке 
представления Calendar (Календарь) в окне отображается другое 
представление.  
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Рис. 1.3. Новое представление в рабочей области Calendar (Календарь) 
 
Среди панелей инструментов есть особая панель — Project Guide 

(Консультант).  
Панель инструментов Project Guide (Консультант) расположена в верхней 

части окна проекта (рис. 1.4).  
 

 
 

Рис. 1.4. Панель инструментов Project Guide (Консультант) 
 
Убрать панель консультанта с экрана можно не только через меню View 

(Вид), не и нажав кнопку ShowjHide Project Guide (Показать/Скрытъ 
консультант), которая расположена на панели инструментов Project Guide 
(Консультант).  
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Включить консультант можно также с помощью пункта меню Tools ~ 
Options (Сервис ~ Параметры). На вкладке Interface (Интерфейс) 
открывшегося окна следует установить флажок Display Project Guide 
(Открывать консультант) или же снять если не нужно, чтобы панель 
консультанта появлялась на экране. Чтобы включить список подсказок 
консультанта, следует нажать одну из кнопок, расположенных на панели 
инструментов Project Guide (Консультант): Tasks (Задачи), Resources 
(Ресурсы), Track (Отслеживание) или Report (Отчет).  

Tasks (Задачи) - отображает в левой части окна Мiсrоsоft Pгoject список 
с/сылок для запуска мастеров планирования и составления календарных 
планов задач проекта.  
Чтобы получить помощь по какому-либо вопросу, следует щелкнуть на 

нужной ссылке.  
Resources (Ресурсы) - отображает список мастеров для создания группы 

проекта и назначения задачам необходимых ресурсов.  
Track (Отслеживание) - отображает список мастеров для отслеживания 

хода выполнения проекта и для управления проектом.  
Report (Отчет) - отображает список мастеров для просмотра состояния 

проекта и создания отчетов.  
Работу с консультантом рассмотрим на примере мастера Define the Project 

(Определение проекта), который находится в списке Tasks (Задачи) панели 
инструментов Project Guide (Консультант).  
В верхней части области мастера отображаются руководства к действию, 

примечания и комментарии, здесь же пользователь вводит необходимые для 
мастера сведения. В нижней части показано количество шагов и порядковый 
номер выполняемого шага, например Step 1 of 3 (Шаг 1 из 3). При создании 
нового проекта следует указать предполагаемую дату начала. После указания 
даты можно переходить к следуюшему шагу работы мастера. Для этого 
нужно щелкнуть на надписи Save and go to Step 2 (Сохранить и перейти к 
шагу 2).  
На втором шаге консультант спрашивает, планируется ли совместная 

работа над проектом. Ответ на этот вопрос дается установкой переключагеля 
в положение Yes (Да) или No (Нет). Затем можно, перейти к следующему 
шагу, щелкнув на надписи Save and go to Step 3 (Сохранить и перейти к шагу 
3), или вернуть к предыдущему шагу, выбрав ссылку Go back to Step 1 
(Вернуться к шагу 1).  
На третьем шаге консультант предлагает сохранить проект . При щелчке 

на надписи Save and Finish (Сохранить и закончить работу) в нижней части 
экрана мастер Define the Project (Определение проекта) сохраняет проект и 
завершает работу. По умолчанию сохранение производится в папку Мои 
документы. Если требуется сохранить данные в другое место, то следует 
выбрать в меню File ~ Save As (Файл ~ Сохранить как) и в появившемся окне 
определить, куда следует сохранить проект.  
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После завершения работы мастера Define the Project (Определение 
проекта) на панели консультанта появится список мастеров той же группы. 
Можно будет выбрать другое действие, например Define general working 
times (Определение рабочего времени проекта). Для удобства работы с 
консультантом можно отвести ему большую площадь на экране, передвинув 
границу между консультантом и используемым представлением проекта, Для 
этого следует поместить указатель мыши на границу так, чтобы он 
превратился в черную двустороннюю стрелку, затем нажать левую кнопку и 
двигать мышь, уменьшая или увеличивая размер панели консультанта.  
Чтобы закрыть список мастеров консультанта, нужно нажать кнопку в 

виде крестика в верхнем правом углу списка.  

1.2. Настройка программы 

Для перехода к настройке MS Project нужно выбрать команду меню 
Tools > Options (Сервис > Параметры). На экране появится диалоговое окно 
настроек, состоящее из нескольких вкладок, на которых сгруппированы 
определяющие работу программы параметры. 

Почти на каждой вкладке есть кнопка Set as Default (По умолчанию), 
позволяющая сохранить сделанные настройки, с тем, чтобы они 
автоматически применялись во всех последующих проектах. Рекомендуется 
нажимать эту кнопку после определения параметров на каждой из вкладок. 

1.2.1. Общие настройки программы 

Вкладка General (Общие) (рис. 1.5) состоит из трех разделов. В 
первом, General options for Microsoft Project (Общие параметры для Microsoft 
Project), расположены общие параметры программы, а в третьем, General 
options for 'Projectl' (Общие параметры для Проект), — общие настройки 
открытого проекта. В разделе между ними, Planning Wizard (Мастер 
планирования), определяется, каким образом MS Project будет отображать 
подсказки при составлении плана проекта. 
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Рис. 1.5. Вид вкладки общих настроек MS Project  
после установки нужных параметров 

 
Флажок Show startup Task Pane (Отображать область задач при 

запуске) определяет, будет ли при загрузке программы отображаться область 
задач, а флажок Open last file on startup (Открывать последний файл при 
запуске) — будет ли загружаться файл, с которым шла работа перед 
закрытием программы. Рекомендуется сбросить оба этих флажка, поскольку 
в процессе выполнения лабораторных работ они не потребуются. 

Прежде чем начать составлять план проекта, нужно ввести в 
специальном диалоговом окне начальные данные о проекте. Флажок Prompt 
for project info for new projects (Запрос на ввод сведений о проекте для новых 
проектов) обеспечивает автоматический вывод на экран этого диалогового 
окна при создании нового проекта.  

В MS Project имеется особый режим просмотра таблиц — Автофильтр 
(AutoFilter), при котором в заголовке каждой таблицы отображается кнопка 
для ее сортировки. Этот режим удобно включается с помощью 
представленной ниже кнопки панели инструментов Formatting 
(Форматирование) и далеко не всегда нужен. Поэтому флажок Set AutoFHter 
on for new projects (Включать автофильтр для новых проектов) лучше 
сбросить. Два последних параметра — счетчик Recently used file list 
(Помнить список из файлов) и флажок User name (Имя пользователя).  
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1.2.2. Настройки редактирования 

Параметры редактирования в MS Project размещены на вкладке Edit 
(Правка) и сгруппированы в двух разделах, один из которых содержит 
настройки, относящиеся к программе в целом, а второй — к открытому в 
данный момент проекту (рис. 1.6). 

 

 
 

Рис. 1.6. Настройки параметров редактирования в MS Project. Общие 
настройки редактирования 

 
Раздел с настройками для MS Project называется Edit options for 

Microsoft Project (Параметры правки для Microsoft Project) и располагается 
вверху диалогового окна. Параметры этого раздела определяют, будет ли 
возможно перетаскивать ячейки таблиц с помощью мыши (флажок Allow cell 
drag and drop), а также будет ли перемещаться курсор в следующую ячейку, 
после того как при редактировании текущей ячейки вы нажали клавишу Enter 
(флажок Move selection after enter).  

Флажок Edit directly into cell (Правка прямо в ячейке) определяет, 
можно ли редактировать данные непосредственно в таблице. Если вы 
сбросите его, то для редактирования данных таблицы необходимо будет 
выделять ячейку и затем вводить ее значение в строке ввода. 



 15

Кроме того, в этом разделе имеется параметр, управляющий способом 
обновления объектов из других файлов, внедренных в файл проекта (OLE-
объекты). Обновление может происходить при открытии файла 
автоматически или по запросу. Для автоматического обновления объектов 
нужно сбросить флажок Ask to update automatic links (Запрашивать об 
обновлении автоматических связей).  

Во втором разделе вкладки Edit (Правка) диалогового окна Options 
(Параметры) вы можете выбрать аббревиатуры, которые MS Project будет 
использовать для обозначения временных единиц в плане проекта, 
диаграммах, отчетах и т. д. Для каждой из единиц (минута, час, день, неделя, 
месяц, год) дается три варианта. Эти настройки относятся к текущему файлу. 

ПРИМЕЧАНИЕ: Выбранные на этой вкладке обозначения временных 
единиц будут использоваться для отображения введенных в файл значений. 
Однако в процессе ввода вы можете использовать любые предлагаемые 
здесь варианты обозначения. 

От состояния флажка Add space before label (Добавлять пробел перед 
надписями) зависит, будет ли вставляться пробел между количеством единиц 
и их обозначением. По умолчанию он установлен, и менять его состояние не 
стоит. 

Параметрами последнего раздела вкладки Edit (Правка) задаются 
цвета, которыми при просмотре проекта будут выделяться обычные 
гиперссылки (список Hyperlink color) и гиперссылки, посещенные ранее 
(список Visited hyperlink color). Эти настройки, как и настройки единиц 
времени, относятся к текущему файлу. 

Флажок Underline hyperlinks (Подчеркивать гиперссылки) определяет, 
будут ли ссылки выделяться подчеркиванием. Рекомендуем оставить его 
установленным, поскольку иначе при редактировании файла можно случайно 
щелкнуть по ссылке, приняв ее за обычный текст, и потерять время на 
загрузку файла из локальной сети или из Интернета. 

1.2.3. Настройки параметров сохранения 

Настройки параметров сохранения присутствуют во всех программах 
семейства Microsoft Office и определяют форматы, в которых сохраняются 
файлы по умолчанию, расположение сохраняемых файлов и параметры 
автоматического сохранения файлов. Параметры сохранения настраиваются 
на вкладке Save (Сохранение) диалогового окна Options (Параметры) 
(рис. 1.7). 
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Рис. 1.7. Параметры сохранения файлов MS Project 

Эта вкладка состоит из раздела общих настроек и раздела настроек, 
относящихся к открытому файлу проекта. Сначала идут параметры, 
определяющие работу MS Project в целом. Первый параметр на этой вкладке 
— раскрывающийся список Save Microsoft Project files as (Сохранять файлы 
Microsoft Project как). В нем вы выбираете формат, который будет 
предлагаться по умолчанию при попытке сохранить файл.  

В области File Locations (Расположение) отображаются имена папок, в 
которых располагаются файлы проектов (строка Projects (Проекты)), 
пользовательские шаблоны (строка User templates (Шаблоны пользователя)), 
шаблоны рабочей группы (строка Workgroup templates (Общие шаблоны)) и 
базы данных ODBC (строка ODBC Database (База данных ODBC)). Выбрав 
нужную строку и нажав кнопку Modify (Изменить), вы можете установить 
значения, соответствующие вашим потребностям. Например, в качестве 
адреса папки с проектами можно указать папку, в которой вы разместили 
файлы с примерами к этой книге. 

В разделе Auto Save (Автосохранение) сгруппированы параметры 
автоматического сохранения открытых для редактирования файлов. Флажок 
со счетчиком Save every ... minutes (Автосохранение каждые ... минут) 
определяет, будет ли осуществляться автоматическое сохранение и с какой 
периодичностью. Мы рекомендуем установить этот флажок и задать 
периодичность сохранения в интервале от 2 до 5 минут. 

Используя два следующих далее переключателя — Save Active Project 
Only (Сохранять только активный проект) и Save all open project files 
(Сохранять все открытые проекты), — вы можете указать, будет ли 
сохраняться автоматически только тот проект, окно которого в данный 
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момент активно, или же все открытые в MS Project проекты. Мы 
рекомендуем сохранять все открытые проекты. 

С помощью флажка Prompt Before Saving (Запрос перед сохранением) 
вы выбираете, выводить или нет запросы на разрешение автоматического 
сохранения.  

Последний раздел, Database save options for 'Project1' (Параметры 
сохранения в базе данных для 'Проект!'), содержит параметр, определяющий 
принцип сохранения открытого в данный момент проекта в формате базы 
данных. Находящийся в этом разделе флажок Expand timephased data in the 
database (Развертывать повременные дайные в базе данных) определяет, как 
будет представлена временная информация о проекте при сохранении плана 
проекта в базе данных (например, при экспорте в MS SQL Server). При 
установленном флажке повременная информация сохраняется, а при 
сброшенном — нет, что существенно ускоряет работу с базой данных. 

1.2.4. Настройки просмотра 

Настройки просмотра проектной информации находятся на вкладке 
View (Вид) (рис. 1.8). Здесь определяются параметры, общие для программы 
и применяемые для открытого файла. 

 

 
 

Рис. 1.8. Параметры просмотра проектной информации 
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В списке Default view (Представление по умолчанию) следует указать, 
какое представление будет открываться при создании нового проекта или 
при запуске программы. (Подробнее о представлениях мы поговорим в конце 
этого урока). С помощью списка Date format (Формат даты) можно 
установить формат представления дат в интерфейсе MS Project. В разделе 
Show (Показывать) расположены флажки, управляющие отображением 
стандартных элементов интерфейса программы: Status bar (Строка 
состояния), Scroll bars (Полосы прокрутки), Entry bar (Строка ввода).  

В этом же разделе перечислены и нестандартные элементы 
интерфейса. Флажок Windows in Taskbar (Окна на панели задач) определяет, 
будет ли каждый открытый проект отображаться отдельной кнопкой на 
панели задач Windows. Если выключить этот режим, то переключаться 
между открытыми проектами можно будет только с помощью меню Window 
(Окно), хотя при этом место на панели задач будет сэкономлено. Мы 
рекомендуем установить этот флажок. 

Часто для экономии места на экране информация отображается 
частично. Например, если длина слова, размещенного в ячейке таблицы, 
превышает ее ширину, то на экране отображается только часть этого слова. 
Если установить флажок Project screentips (Всплывающие подсказки), то в 
таких ситуациях при наведении мыши на ячейку будет появляться 
всплывающая подсказка, отображающая ее содержимое. Кроме того, 
подсказки будут отображаться при наведении мыши на элементы интерфейса 
программы, поэтому мы рекомендуем установить этот флажок. 

С помощью параметров раздела Currency options (Параметры валюты) 
вы можете задать формат представления денежных единиц, в которых 
учитывается стоимость работ проекта. В списке Symbol (Символ валюты) 
следует выбрать символ обозначения денежной единицы. Поскольку в 
примерах мы будем использовать в качестве валюты доллар, вам следует 
выбрать в списке обозначение доллара. Список Placement (Положение 
символа валюты) содержит несколько вариантов размещения символа 
денежной единицы рядом с цифрами. И наконец, счетчик Decimal digits 
(Цифр после запятой) определяет, сколько десятичных знаков будет 
использоваться при отображении стоимости работ. 

1.2.5. Настройки панелей инструментов 

Чтобы освободить место в рабочей области программы на время 
изучения первой части курса, необходимо скрыть ненужные панели — Task 
Pane (Область задач) и Project Guide (Консультант). Кроме того, нужно 
отключить их автоматическое отображение при загрузке. Отключение 
отображения области задач при загрузке программы осуществляется сбросом 
флажка Show at startup (Показывать при запуске), расположенного внизу 
панели. Закрыть панель можно с помощью креста в ее верхнем правом углу. 
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Отключить отображение Консультанта можно только в диалоговом 
окне настройки интерфейса MS Project. Откроем его с помощью команды 
меню Tools >Options (Сервис > Параметры) и перейдем на вкладку Interface 
(Интерфейс). Здесь нужно сбросить флажок Display Project Guide (Открывать 
консультант) (рис. 1.9). 

 

 
 

Рис. 1.9. Параметры настройки интерфейса MS Project 
 

Убрав с экрана ненужные пока панели, следует отобразить одну 
полезную панель, которая называется View Bar (Панель представлений). Для 
этого нужно воспользоваться командой меню View > View Bar (Вид > Панель 
представлений). Теперь настройка MS Project завершена, и окно программы 
должно принять такой вид, как показано на рис. 1.10 
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Рис. 1.10. Окно MS Project после завершения настроек 
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Лабораторная работа № 2 

ТАБЛИЦЫ 

Задание для выполнения работы 

1. В тестовом файле 1.mpp определите, как называется активная таблица. 
Найдите в таблице колонку Cost (Затраты). (Помните, что текст в заголовке 
колонки может не соответствовать названию.) Переименуйте колонку и 
удалите из таблицы все остальные колонки. Модифицированную таблицу 
сохраните под новым названием.  

2. Перенесите в файл 1.mpp из шаблона оригинальную таблицу, которую 
вы изначально модифицировали. В результате в файле 1.mpp должна 
находиться исходная таблица и ее модифицированная копия с одной 
колонкой Cost (Затраты).  

3. Создайте таблицу, содержащую произвольные поля, в том числе и 
текстовые. Сохраните ее. 

4. В текстовое поле введите произвольный текст, состоящий из 
нескольких слов. Отформатируйте столбец, содержащий текст, так, чтобы все 
введенные слова были видны (переход в режим форматирования 
осуществляется двойным щелчком мыши).  

5. Измените, название заголовка одного из столбцов таблицы так, чтобы в 
нем содержалось несколько слов. Сначала отформатируйте заголовок 
колонки так, чтобы все слова были видны в заголовке.  

Контрольные вопросы 

1. Что такое таблица.  
2. Как хранятся и отображаются данные в MS Project (что такое 

«внутренняя» и «внешняя» таблица).  
3. Какие стандартные таблицы входят в состав MS Project.  
4. Как работать со структурой таблицы (добавлять, удалять и 

форматировать столбцы) и изменять ее свойства.  
5. Как создавать таблицы на основе существующих таблиц и «с 

нуля».  
6. Как просматривать, редактировать, форматировать и удалять 

данные в таблицах.  
7. Как форматировать отдельные строки и группы строк таблицы. 

2.1. Типы таблиц MS Project 

Таблицы — это один из основных способов представления проектных 
данных. В проектном файле все данные хранятся в виде двух таблиц, одна из 
которых содержит информацию о задачах, а вторая — о ресурсах проекта, то 
есть задействованных в выполнении задач людях и материальных ценностях. 
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Эти две «внутренние» таблицы состоят из множества полей, большинство из 
которых созданы «про запас» и обычно не используются. В табл. 2.1 и 
табл. 2.2 представлена схема организации данных в MS Project (рис. 2.1).  

 
Таблица 2.1  

Предопределенные таблицы с информацией о задачах 
 

Таблица Содержание 

1 2 
Baseline (Исходный план)  Данные из базового плана проекта  
Constraint Dates (Даты 
ограничений)  

Ограничения задач (даты ограничений и 
типы)  

Cost (Затраты)  Стоимость задач и проекта  
Delay (Задержка)  Информация для уравнивания загрузки 

ресурсов  
Earned Value (Освоенный 
объем)  

Общая таблица для сравнения 
запланированного и фактического объема 
работ, запланированной и фактической 
стоимости  

Earned Value Schedule Indicators 
(Индикаторы календарного 
плана освоенного объема)  

Сравнение запланированного и 
фактического графика выполнения проекта  

Earned Value Cost Indicators 
(Показатели затрат для 
освоенного объема)  

Сравнение запланированного и 
фактического расходования проектного 
бюджета  

Entry (Ввод)  Таблица для ввода общей информации о 
задаче  

Export (Экспорт)  Информация для экспорта данных о задачах 
во внешний файл, более 80 столбцов  

Hyperlink (Гиперссылка)  Связанные с задачей ссылки, ведущие на 
внешние сайты и файлы в интранете  

PA_Expected Case (Ожидаемый 
сценарий)  

Таблицы для анализа плана проекта с 
помощью методики PERT  

PA_Optimistic Case 
(Оптимистичный сценарий)  
PA_Pessimistic Case 
(Пессимистичный сценарий)  

Идентичны по структуре и содержат 
данные об ожидаемом (Expected), 
оптимистичном (Optimistic) и 
пессимистичном (Pessimistic) планах 
проекта  

PA_PERT Entry Sheet (Ввод для 
анализа PERT)  

Таблица для ввода данных, используемых 
при проведении анализа плана по методике 
PERT  

Rollup Table (Сводные задачи)  Служит для оптимизации отображения 
сводных задач  
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Окончание табл. 2.1 
1 2 

Schedule (Календарный 
план)  

Расписание начала и окончания выполнения задач, 
интервалы между задачами  

Summary (Суммарные)  Общая информация о задачах проекта  
Tracking 
(Отслеживание)  

Актуальная проектная информация  

Usage (Использование)  Задачи проекта, объем работ, длительность, даты 
начала и окончания  

Variance (Расхождение)  Данные об отклонении от плана при исполнении 
работ  

Work (Трудозатраты)  Информация об объеме работы по проекту  
 

Таблица 2.2 
Предопределенные таблицы с информацией о ресурсах 

 
Таблица Содержание 

Cost (Затраты)  Стоимость ресурсов проекта  
Earned Value (Приобретенная 
стоимость)  

Сравнение запланированной и 
фактической стоимости ресурса в проекте  

_Entry (Ввод)  Таблица для ввода общей информации о 
ресурсе  

Entry — Material Resources (Ввод 
материального ресурса)  

Таблица для ввода общей информации о 
материальном ресурсе  

Entry — Work Resources (Ввод 
нематериального ресурса)  

Таблица для ввода общей информации о 
нематериальном ресурсе  

Export (Экспорт)  Информация для экспорта данных о 
ресурсах во внешний файл  

Hyperlink (Гиперссылка)  Связанные с ресурсом ссылки, ведущие на 
внешние сайты и файлы в интранете  

Summary (Сводная)  Общая информация о ресурсах проекта  
Usage (Использование)  Информация о работе, на которую 

выделены ресурсы  
Work (Работа)  Информация об объеме работы, на 

которую выделены ресурсы  
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Рис. 2.1. Схематическое представление организации данных в MS Project 

2.2. Просмотр данных с помощью таблиц 

Как мы уже знаем, «внутри» MS Project есть таблица ресурсов и 
таблица задач, а «снаружи», в интерфейсе, есть ряд таблиц, являющихся 
набором полей либо из одной, либо из другой «внутренней» таблицы. 

Таблицы отображаются в представлениях, причем есть представления, 
в которых таблицы совмещены с диаграммой (например, Gantt Chart 
(Диаграмма Ганта)), а есть и состоящие из одной таблицы (например, 
Resource Sheet (Лист ресурсов) (рис. 2.2). 

 

 
Рис. 2.2. Представление, состоящее из одной таблицы  

Resource Sheet (Лист ресурсов) 
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В настройках представления определено, какая таблица открывается 
по умолчанию при его загрузке. При этом в любой момент можно вывести на 
экран другую таблицу такого же типа. Например, в представлении Gantt 
Chart (Диаграмма Ганта) при открытии отображается таблица Entry (Ввод 
данных), а в представлении Task Usage (Использование задач) — таблица 
Usage (Использование). Но при желании можно отобразить таблицу Entry 
(Ввод данных) в представлении Task Usage (Использование задач) или 
таблицу Task Usage (Использование задач) в представлении Gantt Chart 
(Диаграмма Ганта). 

Таким образом, в представлении заложено ограничение на тип 
отображаемых таблиц (таблицы с данными о задачах или ресурсах), но 
просматривать в нем можно любые таблицы этого типа. Переключение 
между таблицами осуществляется с помощью команды меню View > Table 
(Вид > Таблица). Например, для того чтобы отобразить в представлении 
Gantt Chart (Диаграмма Ганта) таблицу Task Usage (Использование задач), 
перейдите к этому представлению, щелкнув на соответствующем значке 
панели представлений, а затем выберите команду меню View > Table (Вид > 
Таблица) и в появившемся списке таблиц выберите Usage (Использование) 
(рис. 2.3). 

 

 
 

Рис. 2.3. Выбор новой таблицы для отображения в представлении  
Gantt Chart (Диаграмма Ганта) 

 
В результате поля в таблице обновляются (рис. 2.4): появляется поле 

Work (Трудозатраты), пропадают поля Predecessors (Предшественники) и 
Resource Names (Названия ресурсов). 
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В списке, появляющемся при выборе команды View > Table (Вид > 
Таблица), перечислены наиболее часто используемые таблицы для текущего 
представления. Если же этот список не содержит нужной таблицы, то ее 
можно найти, щелкнув на расположенном внизу списка пункте More Tables 
(Другие таблицы). 

После щелчка откроется диалоговое окно со списком всех таблиц, 
доступных для отображения в представлениях MS Project (рис. 2.5). Таблицы 
разделены на две группы: Task (Задачи) и Resource (Ресурсы), согласно типу 
отображаемой в них информации. Выбор группы таблиц осуществляется с 
помощью переключателей в верхней части диалогового окна. 

По умолчанию в этом диалоговом окне загружается список таблиц 
того типа, который возможно отобразить в текущем представлении, и среди 
них выделяется открытая в данный момент таблица.  

 

 
 

Рис. 2.4. Отображение таблицы Usage (Использование) 
 

Для того чтобы нужная вам таблица отобразилась в представлении, 
достаточно выбрать ее из списка и нажать кнопку Apply (Применить). Чтобы 
вернуться в представление, не выбирая таблицу, нужно нажать кнопку Cancel 
(Отмена) или просто закрыть окно. 
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Рис. 2.5. Диалоговое окно выбора таблицы из полного списка для 
отображения в текущем представлении 

 
Хотя разделение по типам отображаемой информации является 

ключевым для представлений, совсем не обязательно запоминать, к какому 
типу относится то или иное представление или таблица. В процессе работы 
MS Project просто не позволит отобразить в представлении не 
соответствующую по типу таблицу. 

Например, если вы захотите отобразить в представлении Gantt Chart 
(Диаграмма Ганга) (которое содержит информацию о задачах) таблицу с 
данными о ресурсах, переключившись в соответствующий список выбора 
таблиц, то не сможете этого сделать, поскольку кнопка Apply (Применить) 
будет заблокирована (рис. 2.6). 

 

 
 

Рис. 2.6. Программа не позволяет отобразить не соответствующую 
представлению таблицу 
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2.3. Добавление, удаление и форматирование колонок 

Таблицы, входящие в комплект поставки MS Project, являются 
удобным средством для быстрого получения нужной информации. Тем не 
менее, набор столбцов, по умолчанию включенных в таблицы, не всегда 
может подходить к вашим задачам. В таком случае его можно изменить. 

Добавить столбец в таблицу можно двумя путями: с помощью 
команды Insert > Column (Вставка > Столбец) основного меню или команды 
Insert Column (Вставить столбец) контекстного меню. Чтобы эта команда 
появилась в контекстном меню, необходимо предварительно выделить одну 
из колонок таблицы, щелкнув по ее заголовку. После этого открывается 
диалоговое окно определения свойств колонки (рис. 2.7). 

 

 
 

Рис. 2.7. Диалоговое окно определения свойств  
добавляемой в таблицу колонки 

 
Поле Field name (Имя поля) представляет собой раскрывающийся 

список полей, которые можно добавить в таблицу (поля из «внутренней» 
таблицы того же типа, что и настраиваемая). Название поля отображается в 
заголовке колонки, и если вы хотите, чтобы там было указано другое 
название, то его нужно ввести в поле Title (Текст заголовка). 

В раскрывающихся списках Align title (Выравнивание заголовка) и 
Align data (Выравнивание данных) определяется ориентация текста в 
заголовках столбцов: Right (По правому краю), Center (По центру) или Left 
(По левому краю). Счетчик Width (Ширина) задает ширину столбца в 
символах. 

Если в заголовке столбца используется несколько слов, и все они не 
умещаются в заголовке из-за его небольшой ширины, поможет флажок 
Header Text Wrapping (Перенос заголовка по словам). Если его установить, то 
неумещающиеся слова будут автоматически переноситься на следующую 
строку. 

Когда вы установили требуемые значения параметров колонки, для 
добавления колонки в таблицу щелкните на кнопке ОК или же на кнопке Best 
Fit (Автоширину), которая автоматически подберет добавляемой колонке 
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оптимальную ширину (в таком случае значение поля Width будет 
игнорироваться). 

Для редактирования свойств добавленной в таблицу колонки нужно 
выполнить двойной щелчок на ее заголовке. После этого отобразится уже 
знакомое диалоговое окно, в котором можно внести необходимые изменения. 
Для автоматического подбора оптимальной ширины колонки нужно навести 
курсор на правую границу заголовка колонки (курсор в этот момент примет 
вид креста с направленными вправо и влево стрелками) и сделать двойной 
щелчок. 

Чтобы убрать ненужную колонку, следует выделить ее, щелкнув на ее 
заголовке, а затем в контекстном меню колонки (рис. 2.8) выбрать команду 
Hide Column (Скрыть столбец). После этого колонка будет убрана из 
таблицы. 

 

 
 

Рис. 2.8. Чтобы убрать колонку из таблицы, выделите ее и в контекстном 
меню выберите команду Hide Column (Скрыть столбец) 

 
При удалении и добавлении колонок в таблицы изменение структуры 

автоматически сохраняется, и в дальнейшем щелчок на названии таблицы в 
меню будет отображать ее с новой структурой. Если же вы хотите изменять 
таблицы, сохраняя при этом их начальные варианты, вам необходимо 
освоить принципы создания и редактирования таблиц. 

2.4. Создание новой таблицы 

Для осуществления операций по созданию и удалению таблиц 
необходимо открыть диалоговое окно со списком всех таблиц, доступных в 
открытом проекте. Уже знакомое нам диалоговое окно (см. рис. 2.5) 
открывается с помощью команды меню View > Table > More Tables (Вид > 
Таблица > Другие таблицы). 
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Чтобы создать таблицу, нужно щелкнуть на кнопке New (Создать). 
При этом появится диалоговое окно определения свойств таблицы (рис. 2.9). 
Здесь задается название таблицы, состав ее полей и их формат, а также 
дополнительные параметры отображения таблицы в интерфейсе MS Project. 

Нужно иметь в виду, что тип создаваемой таблицы (и, соответственно, 
набор доступных столбцов) зависит от того, какого типа таблицы 
просматривались в списке таблиц в момент нажатия кнопки New (Создать). 

 

 
 

Рис. 2.9. Диалоговое окно определения свойств создаваемой таблицы 
 
Название таблицы указывается в поле Name (Имя). Флажок Show in 

menu (Показывать в меню) определяет, будет ли новая таблица отображаться 
в списке таблиц, открывающемся в подменю View > Table (Вид > Таблица). 

Флажок Lock first column (Зафиксировать первый столбец) влияет на 
отображение первой колонки: будет ли она выглядеть, как обычная колонка, 
или же будет защищена от ввода и выделена серым цветом. В настройках 
таблицы, этот флажок установлен, поэтому первая колонка с номерами задач 
выделена серым цветом и ее нельзя редактировать. 

Формат представления дат в ячейках таблицы выбирается в списке 
Date format (Формат даты). Вариант Default (По умолчанию) соответствует 
формату, определенному для всего проекта на вкладке View (Вид) 
диалогового окна Options (Параметры) (открываемого командой меню Tools 
> Options (Сервис > Параметры)). 

В счетчике Row height (Высота строк) задается высота строк в новой 
таблице. Единица означает стандартную высоту, а другие цифры 
соответствуют кратности увеличения высоты относительно стандартной. 

Установка флажка Auto-adjust header row heights (Автонастройка 
высоты строки заголовков) обеспечивает подбор высоты заголовка колонок 
так, чтобы в нем уместились все слова из его названия. Этот флажок имеет 
смысл устанавливать, если название состоит из нескольких слов, так как в 
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таком случае слова, перенесенные из-за ширины заголовка на вторую или 
третью строки, могут оказаться скрытыми за границей заголовка. 

В центре рассматриваемого диалогового окна располагается раздел 
Table (Таблица), в котором формируется структура новой таблицы. Этот 
раздел состоит из ряда кнопок, строки ввода и таблицы, каждая строка 
которой соответствует колонке в новой таблице, а столбцы — свойствам этой 
колонки. 

Для добавления колонки в новую таблицу нужно щелкнуть мышью в 
ячейке столбца Field Name (Имя поля) и в появившемся раскрывающемся 
списке выбрать название колонки. После этого в этой строке будут 
автоматически заполнены другие поля, определяющие свойства новой 
колонки. Эти поля уже знакомы нам по диалоговому окну определения 
свойств таблицы (см. рис. 2.3 и рис. 2.7); для их редактирования можно 
использовать строку ввода. 

Кнопки Cut Row (Вырезать строку) и Copy Row (Копировать строку) 
позволяют поместить строку в буфер обмена, удалив (в первом случае) или 
же сохранив ее в таблице. Вставить скопированную или вырезанную строку 
можно с помощью кнопки Paste Row (Вставить-строку). 

Чтобы вставить строку в таблице между существующими строками, 
нужно установить курсор на ту строку, над которой нужно вставить новую, и 
нажать кнопку Insert Row (Добавить строку). Удаление строк осуществляется 
с помощью кнопки Delete Row (Удалить строку), причем MS Project не 
выводит дополнительное предупреждение перед удалением. 

После ввода всех параметров новой таблицы для их сохранения нужно 
нажать кнопку ОК. 

2.5. Редактирование таблиц 

После того как новая таблица создана, может потребоваться внести в 
нее изменения. Структуру таблицы и свойства колонок можно редактировать 
непосредственно в представлении, но некоторые ее свойства (например, 
формат дат) можно изменить только в окне определения свойств таблицы. 

СОВЕТ: Для быстрого изменения высоты всех строк таблицы во 
время ее просмотра нужно выделить всю таблицу (щелкнув на заголовке 
первой колонки, если она зафиксирована), а затем изменить высоту любой 
из ее строк, перетащив мышью одну из ее границ. Все строки таблицы 
автоматически примут тот же размер, что и изменяемая строка. 

Для того чтобы открыть окно для редактирования свойств 
существующей таблицы, нужно сначала открыть диалоговое окно со списком 
таблиц, используя команду меню View > Table > More Tables (Вид > Таблица 
> Другие таблицы), а затем выбрать в списке необходимую таблицу и 
щелкнуть на кнопке Edit (Изменить). Теперь, когда вы обладаете всеми 
необходимыми знаниями для создания собственной таблицы, пора 
попробовать свои силы на практике. 
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2.6. Форматирование данных в таблицах 

Возможности форматирования содержимого таблиц в MS Project 
довольно развиты. Во-первых, есть возможность изменять шрифт и цвет 
данных в ячейках и столбцах. Для этого нужно выделить ячейку (установив в 
нее курсор и щелкнув мышью) или столбец (щелкнув по его заголовку), а 
затем вызвать диалоговое окно определения свойств шрифта (см. рис. 2.9) 
через меню Format > Font (Формат > Шрифт). Это диалоговое окно можно 
вызвать и выбором команды Font (Шрифт) в контекстном меню, которое 
появляется при щелчке правой кнопкой мыши по выделенной ячейке или 
столбцу. 

Диалоговое окно определения свойств шрифта (рис. 2.10) содержит 
несколько полей, с помощью которых можно задать тип шрифта (поле Font), 
его начертание (поле Font style), размер (счетчик Size) и цвет (список Color), 
а также добавить эффект подчеркивания (флажок Underline (Подчеркнуть)). 
В области Sample (Образец) отображается пример применения выбранных 
настроек шрифта. 

 

 
 

Рис. 2.10. Диалоговое окно определения свойств шрифта 
 

СОВЕТ: Для быстрого изменения параметров шрифта можно 
воспользоваться панелью инструментов Formatting (Форматирование) (рис. 
2.11). На ней расположены элементы для быстрого изменения любого 
параметра оформления данных в ячейке, кроме цвета шрифта. Кроме того, 
некоторые параметры оформления можно менять с помощью 
стандартных для программ Microsoft сочетаний клавиш: Ctrl+В выделяет 
данные полужирным шрифтом, Ctrl+I — курсивом и Ctrl+U — 
подчеркиванием. 
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Рис. 2.11. Панель форматирования данных в ячейке 
 

Во-вторых, MS Project позволяет одновременно форматировать строки 
таблицы, относящиеся к задачам или ресурсам определенного типа. Для 
этого нужно выбрать команду меню Format > Text Styles (Формат > Стили 
текста) или воспользоваться командой Text Styles (Стили текста) контестного 
меню, которое отображается при щелчке правой кнопки мыши по 
выделенной колонке таблицы. 

Диалоговое окно изменения текстовых стилей (рис. 2.12) является 
аналогом диалогового окна определения свойств шрифта (см. рис. 2.10). 
Единственное отличие — это присутствие списка Item to Change 
(Изменяемый). Выбрав нужный элемент из этого списка, можно затем 
изменять его шрифт, стиль, размер и использовать дополнительные эффекты. 

 

 
 

Рис. 2.12. Диалоговое окно определения свойств текстовых стилей 
 
Список приведенных в списке элементов зависит от типа таблицы, 

открытой в текущем представлении. Например, диалоговое окно на рис. 2.11 
вызвано щелчком по таблице в представлении Gantt Chart (Диаграмма Ганта), 
поэтому в списке элементов приведены различные типы задач. 

В списке элементов, доступных для форматирования, всегда есть 
пункт Row & Column Titles (Заголовки строк и столбцов), выбрав который, 
можно изменить шрифтовое оформление заголовков колонок и данных в 
первой колонке (если она заблокирована). 
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В качестве примера отформатируем курсивом все задачи, являющиеся 

критическими для проекта. Для этого выберем в списке Item to Change 
(Изменяемый) пункт Critical Tasks (Критические задачи) и изменим 
начертание шрифта на полужирный курсив в списке Font style (Начертание). 
В результате все строки таблицы, относящиеся к критическим задачам, 
автоматически будут выделены. 
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Лабораторная работа № 3 

СОРТИРОВКА, ГРУППИРОВКА И ФИЛЬТРАЦИЯ  

ДАННЫХ В ТАБЛИЦАХ 

Задание для выполнения работы 

1. Включите режим автофильтра и с его помощью отберите задачи, 
затраты на которые находятся в диапазоне от $50 до $150.  

2. Сохраните настройки автофильтра в новом фильтре.  
3. В таблице выберите задачи с уровнем структуры 1, 2 и 3.  
4. Сгруппируйте задачи по объему работы с интервалом в 10 часов. 

Сохраните созданную группу в списке групп.  
5. Теперь примените группировку только к критическим задачам, 

отобрав их с помощью фильтра.  
6. Измените ранее созданную группу таким образом, чтобы в нее 

включались и суммарные задачи. Сохраните новую группу под новым 
именем и примените группировку.  

7. Отмените группировку и отсортируйте данные в таблице по 
объему работы по убыванию, сохранив структуру. Затем отсортируйте задачи 
без сохранения структуры. Верните данные в таблице к исходному виду.  

Контрольные вопросы 

1. Принципы сортировки, группировки и фильтрации данных в 
таблицах.  

2. Как пользоваться структурной фильтрацией и автофильтром.  
3. Как создавать фильтры на основе существующих фильтров и 

автофильтра.  
4. Как настраивать параметры группировки данных и группировки с 

интервалами.  
5. Как создавать и редактировать группы.  
6. Как одновременно использовать сортировку, группировку и 

фильтрацию.  

3.1. Сортировка 

Несмотря на то, что проектные данные распределены по 
представлениям, каждое представление может содержать слишком большой 
объем информации. Поэтому очень важно уметь отбирать из данных, 
отображаемых в представлениях, только нужные. 

Сортировка позволяет изменять порядок записей в таблице по 
возрастанию или убыванию значений в одном или нескольких ее полях. 
Например, можно отсортировать задачи по трудозатратам и в 



 36

отсортированной таблице увидеть, какие задачи требуют наименьших 
трудозатрат, а какие — наибольших. 

Таблицы, отображаемые в представлениях, являются уменьшенными 
вариантами «внутренних» таблиц. Поэтому сортировать записи во 
«внешних» таблицах вы сможете по любому из столбцов «внутренней» 
таблицы, а не только по тем столбцам, которые включены в структуру 
«внешней» таблицы. 

ВНИМАНИЕ: При сортировке изменяется порядок только видимых в 
таблице в момент сортировки записей. Записи, не отображенные в 
результате фильтрации или находящиеся внутри свернутой суммарной 
задачи, не сортируются. 

Чтобы применить сортировку, следует воспользоваться подменю 
Project > Sort (Проект > Сортировка). В этом подменю (рис. 3.1) содержится 
набор стандартных вариантов сортировки для текущего типа таблицы. 

 

 
 

Рис. 3.1. Меню сортировки данных в MS Project 
 
Если в таблице отображается информация о задачах, то в меню будут 

представлены следующие варианты сортировки: by Start Date (по дате 
начала), by Finish Date (по дате окончания), by Priority (по приоритету), by 
Cost (по затратам) и by ID (no идентификатору). Если же в таблице 
содержатся данные о ресурсах, то в меню будут представлены варианты 
сортировки by Cost (по затратам), by Name (по названию) и by ID (по 
идентификатору). 

Последний пункт в списке, Sort by (Сортировать по), вызывает окно 
сортировки, в котором можно настроить параметры сортировки 
самостоятельно. Этот пункт присутствует в списке независимо от текущего 
типа таблицы. 

Для быстрого вызова окна сортировки можно выделить любую из 
колонок таблицы, затем щелкнуть на ней правой кнопкой мыши и в 
раскрывшемся контекстном меню выбрать команду Sort by (Сортировать по). 

Диалоговое окно сортировки (рис. 3.2) позволяет выбрать до трех 
полей, по которым будет осуществляться сортировка записей таблицы. 
Сортировка выполняется последовательно, сначала по первому полю, потом 
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по второму и затем — по третьему (счет идет сверху вниз). При этом для 
каждого выбранного поля можно указать порядок сортировки — по 
возрастанию (переключатель Ascending (По возрастанию)), когда в начале 
таблицы отображаются записи с наименьшими значениями в этом поле, или 
по убыванию (переключатель Descending (По убыванию)), когда в начале 
таблицы отображаются записи с наибольшими значениями.  

 

 
 

Рис. 3.2. Окно сортировки MS Project 
 
После нажатия кнопки Sort (Сортировать) данные в таблице 

сортируются в соответствии с заданными параметрами. Для восстановления 
исходного порядка строк в таблице нужно выбрать команду меню Project > 
Sort > by ID (Проект > Сортировка > по идентификатору), поскольку 
значение в столбце с идентификатором соответствует порядковому номеру 
строки. Правда, сортировка по идентификатору вернет задачи в исходное 
представление только в том случае, если ранее при сортировке не был 
установлен флажок Permanently renumber tasks (Перенумеровать задачи), 
поскольку в противном случае строки перенумеровываются в порядке, 
соответствующем их положению после сортировки. 

3.2. Фильтрация 

При работе с проектными планами, содержащими большое число 
задач и ресурсов, часто требуется отображать в таблицах не все доступные 
данные, а только некоторую их часть. Для отбора строк, отображаемых в 
таблицах, служат средства фильтрации: структурная фильтрация, автофильтр 
и фильтры. 
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3.2.1. Структурная фильтрация 

Проектный план имеет структуру, или уровни вложенности. Есть 
задачи, находящиеся на верхнем уровне проекта, а также задачи, 
расположенные «внутри» фаз, их подфаз и т. д. 

Фильтрация на основе расположения задач в структуре плана проекта 
— самый простой способ сократить число отображаемых строк в таблицах. 
Для ее осуществления необходимо указать, задачи с каким максимальным 
уровнем вложенности вы хотите видеть в плане. 

Структурная фильтрация осуществляется с помощью команды меню 
Project > Outline > Show (Проект > Структура > Показать). При этом 
открывается список уровней вложенности задач (Outline Level (Уровень)) — 
от 1 до 9 (рис. 3.3). 

 

 
 

Рис. 3.3. Меню для структурной фильтрации списка задач проекта 
 
ПРИМЕЧАНИЕ: В таблице рядом с элементами, содержащими 

элементы нижнего уровня, расположены значки, позволяющие отображать 
и скрывать их. Подменю Project > Outline (Проект > Структура) содержит 
команду Hide Outline Symbols (Скрыть символы структуры), с помощью 
которой эти значки могут быть убраны. Для отображения этих значков 
можно воспользоваться этой же командой — она поменяет название на 
Show Outline Symbols (Показать символы структуры). 

Выбрав первый уровень, вы увидите в таблице только задачи и фазы 
самого высокого уровня, выбрав второй — фазы и задачи верхнего уровня и 
их подзадачи. Выбор любого следующего уровня сохраняет видимыми 
задачи и фазы предыдущего уровня и отображает новые. Для отображения 
всех фаз и задач плана проекта служит команда меню AUSubtasks (Все 
подзадачи). 

 



 39

Для быстрого обращения к меню уровней вложенности задач можно 
использовать кнопку Show (Показать) на панели инструментов Formatting 
(Форматирование). Нажатие на нее (рис. 3.4) сразу отображает это меню. 

 

 
 

Рис. 3.4. Обращение к меню структурной фильтрации с помощью 
панели инструментов Formatting (Форматирование) 

 
Для того чтобы лучше представить, как MS Project определяет уровни 

задач, можно вставить в таблицу столбец Outline Level (Уровень структуры). 
Число, которое будет отображаться в этом столбце напротив каждой задачи и 
фазы (рис. 3.4), и будет номером ее уровня, на основании которого 
осуществляется сортировка. 

3.2.2. Автофильтр 

Автофильтр — это широко применяемая в продуктах Microsoft 
методика фильтрации данных в таблицах. После включения режима 
автофильтра в заголовке каждой из колонок появляются кнопки, с помощью 
которых осуществляется фильтрация строк в таблице. Нажатием кнопки 
вызывается раскрывающееся меню, позволяющее определить значение или 
список значений, которые должна содержать колонка. После выбора такого 
значения в таблице отображаются только те строки, в которых колонка 
содержит определенное значение. 

Включение автофильтра осуществляется с помощью кнопки AutoFilter 
(Автофильтр) на панели инструментов Formatting (Форматирование) или с 
помощью команды меню Project > Filtered for > AutoFilter (Проект > Фильтр 
> Автофильтр). Сразу после выбора команды меню или нажатия кнопки 
панели инструментов в заголовках столбцов отображаются кнопки для 
фильтрации (рис. 3.5). 
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Рис. 3.5. После включения автофильтра в заголовках столбцов 
таблицы появились кнопки для фильтрации 

 
Во многих случаях в качестве критерия должно служить не одно 

значение, а несколько, или же определенное условие на значение, например 
«не более 3», «меньше или равно 3» и т. д. Для ввода таких расширенных 
критериев фильтрат служит диалоговое окно настройки автофильтра, 
вызываемое с помощью пунк 1 (Custom) — (Условие) в раскрывающемся 
списке автофильтра (рис. 3.6). 

 

 
 

Рис. 3.6. Диалоговое окно настройки автофильтра 
 

В названии единственного раздела этого диалогового окна указано 
название столбца, по значениям которого осуществляется фильтрация. В 
нашем случае это поле Outline Level (Уровень структуры). При загрузке в 
диалоговом окне отображается текущий критерий автофильтра. Критерий 
состоит из условия (например, «равно»), отображаемого в левом 
раскрывающемся списке, и значения (например, 2), причем набор условий, 
предлагаемых для отбора строк, зависит от типа поля (табл. 3.1). 
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Таблица 3.1  
Виды условий, используемые для фильтрации 

 
Тип поля 

Название Перевод 
Текст Число 

Equals равно  + + 
does not equal  не равно  + + 
is greater than  больше  + + 
is greater than or equal to  больше или равно  + + 
is less than  меньше  + + 
is less than or equal to  меньше или равно  + + 
is within  в пределах  + + 
is not within  вне  + + 
Contains  содержит  +  
does not contain  не содержит  +  
contains exactly  содержит точно  +  
 
СОВЕТ: В качестве значения условия автофильтра можно задавать 

не только число, но и значения в других столбцах. Например, если вы хотите 
отобрать те строки, где фактическая стоимость больше запланированной, 
то в диалоговом окне настройки автофильтра для поля Actual Cost 
(Фактические затраты) нужно указать условие «больше», а в качестве 
значения в квадратных скобках название поля Cost (Затраты): [Cost] 
([Затраты]). 

3.2.3. Фильтры 

Применение автофильтра ограничивается тем, что его можно 
использовать только для фильтрации таблиц на основании данных в 
столбцах, причем не более чем по двум условиям. Фильтры же лишены этих 
ограничений и могут использоваться для полноценного отбора данных. 

Фильтр — это сохраненный набор условий и значений фильтрации, 
согласно которому происходит отбор информации для отображения в 
представлении MS Project. Фильтры содержат условия на значения в 
столбцах, и поэтому (так же, как и таблицы) делятся на два типа: 
относящиеся к ресурсам и задачам. Соответственно, применить фильтр 
можно только к таблице одного типа с ним. 

MS Project содержит набор предопределенных фильтров, которые 
позволяют быстро отбирать из таблиц наиболее необходимые данные. Работа 
с фильтрами осуществляется через подменю Project > Filtered for: (Проект > 
Фильтр). В пункте Filtered for: (Фильтр) (рис. 3.7, файл 1.mpp) указано 
название выбранного в данный момент фильтра, а при наведении на него 
курсора открывается подменю со списком фильтров, которые можно 
использовать для текущей таблицы. В подменю отображается неполный 
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список фильтров. Полный список фильтров можно получить, щелкнув на 
пункте More Filters (Другие фильтры). 

 

 
 

Рис. 3.7. Работа с фильтрами осуществляется через подменю Project > 
Filtered for: (Проект > Фильтр) 

 
Помимо меню для быстрого доступа к полному списку фильтров 

можно воспользоваться панелью форматирования (рис. 3.8). Как вы можете 
заметить, первым пунктом в списке (и на панели, и в меню) идет фильтр All 
Tasks1 (Все задачи), при использовании которого отображаются все записи 
таблицы. Этот фильтр включен по умолчанию. (При открытой таблице с 
информацией о ресурсах фильтр будет называться All Resources (Вce 
ресурсы)). 

 

 
 

Рис. 3.8. Панель форматирования позволяет получить быстрый доступ 
к фильтрам 

 
Фильтрация может выполняться и в другом режиме, когда строки 

таблицы, удовлетворяющие критериям, выделяются цветом, а остальные 
продолжают отображаться. Для того чтобы выделить цветом 



 43

соответствующие условиям фильтра строки, нужно выбрать команду меню 
Project > Filtered for > More Filters (Проект > Фильтр > Другие фильтры), а 
затем в открывшемся диалоговом окне со списком всех фильтров выбрать 
нужный фильтр и нажать кнопку Highlight (Выделить). Переключатели 
вверху диалогового окна позволяют переключаться между списками 
фильтров разных типов. 

Выбранный в списке фильтр можно отредактировать, а также 
скопировать и создать на его основе новый фильтр, нажав соответствующую 
кнопку диалогового окна. Нельзя изменить лишь три фильтра: All Tasks/All 
Resources (Все задачи/Все Ресурсы) и Using Resource (Использование 
ресурса). 

3.2.4. Создание фильтра 

Для создания собственного фильтра следует в диалоговом окне More 
Filters (Другие фильтры) (рис. 3.9) выбрать тип фильтра и нажать кнопку 
New (Создать).После этого откроется диалоговое окно определения свойств 
фильтра (рис. 3.10). 

 

 
 

Рис. 3.9. Диалоговое окно со списком всех фильтров напоминает 
аналогичное окно со списком таблиц 
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Рис. 3.10. Диалоговое окно редактирования свойств фильтра 
аналогично диалоговым окнам определения свойств таблиц и настройки 

автофильтра 
 

Диалоговое окно содержит уже знакомые элементы. В поле Name 
(Имя) вводится название фильтра. Флажок Show in menu (Показывать в 
меню) определяет, будет ли название фильтра включено в список, 
отображаемый в подменю Project > Filtered for: (Проект > Фильтр). 

В центре диалогового окна находится раздел Filter (Фильтр), в 
котором определяется критерий отбора данных. Поскольку критерий может 
состоять из нескольких условий, для их ввода предназначена таблица, 
состоящая из нескольких столбцов. Каждая строка таблицы соответствует 
условию. 

Первый столбец, And/Or (И/Или), определяет связь условий внутри 
критерия: должны ли строки, отбираемые фильтром, соответствовать всем 
условиям (И) или же достаточно соответствия только некоторым (Или). При 
наличии в таблице единственного условия заполнять это поле не нужно. 

ВНИМАНИЕ: Группы условий, объединенных с помощью логических 
операторов, можно объединять логическими операторами с другими 
группами или условиями, то есть как бы заключать в скобки. Чтобы 
создать условие, объединяющее группу, нужно создать новую строку и 
поместить на нее только условие. 

Во втором столбце, Field Name (Имя поля), определяется, на 
основании какого поля будет осуществляться фильтрация. Название поля 
выбирается из списка, в котором представлены все названия полей из 
«внутренней» таблицы соответствующего типа. 

Третий столбец, Test (Проверка), содержит логическое условие, 
например «равно». Условие выбирается из списка, причем этот список может 
содержать разный набор условий в зависимости от типа данных в поле Field 
Name (Имя поля). 
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И последний столбец, Value(s) (Значения), определяет, с каким 
значением при проверке условия сравниваются данные из столбца Field Name 
(Имя поля). В качестве значений могут выступать как произвольные 
величины, вводимые вручную, так и значения других столбцов таблицы. 
Например, на рис. 3.10 первое условие фильтра требует, чтобы отбирались 
задачи, стоимость работ по которым составляет более $1000, а на рис. 3.11 
фильтр для отбора задач, стоимость которых превысила бюджет, отсеивает 
их, сравнивая реальный объем работ с изначально запланированным. 

 

 
 

Рис. 3.11. Фильтр, выбирающий задачи с превышением бюджета, 
сравнивает реальный объем работ по задачам с изначально запланированным 

 
СОВЕТ: В MS Project есть возможность создавать фильтры, 

запрашивающие значение для сравнения при каждом запуске (например, 
минимальную стоимость работ по задаче). Для того чтобы создать такой 
интерактивный фильтр, нужно в поле Value(s) (Значения) указать в 
кавычках текст, который фильтр будет выводить в качестве вопроса, и 
знак вопроса, например так: «Минимальная стоимость задачи». 

Примером такого фильтра является стандартный фильтр Data Range 
(Диапазон дат). На его примере видно, что запросы значений можно создать 
для каждого из условий фильтра. Если перечислить такие условия через 
точку с запятой, то фильтр отобразит поочередно несколько запросов, в 
зависимости от того, сколько условий будет перечислено. Например, можно 
задать условие проверки is within (внутри) и затем в поле значения ввести 
текст: «Минимум:»?; «Максимум:»?. В этом случае программа отобразит 
запрос на ввод минимального и максимального значений для фильтрации. 

Кнопки, расположенные над таблицей условий, используются для 
выполнения операций над ее строками. Кнопки Cut Row (Вырезать строку) и 
Copy Row (Копировать строку) позволяют поместить строку в буфер обмена 
(в первом случае — с удалением из таблицы). Вставить скопированную или 
вырезанную строку можно с помощью кнопки Paste Row (Вставить строку). 
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Чтобы вставить строку в таблице между существующими строками, 
нужно установить курсор на ту строку, над которой необходимо вставить 
новую, и нажать кнопку Insert Row (Добавить строку). Удаление строк 
осуществляется с помощью кнопки Delete Row (Удалить строку), причем 
перед удалением предупреждение не будет отображаться. 

Флажок Show related summary rows (Показывать связанные 
суммарные строки) определяет, будут ли при фильтрации отображаться 
только задачи, соответствующие условиям (в таком случае не 
прослеживается структура плана проекта), или же вместе с задачами будут 
отображаться и названия фаз, в которые эти задачи включены. 

3.3. Группировка 

Задачи при составлении плана проекта группируются внутри фаз, к 
которым они относятся, ресурсы же не сгруппированы никак и представлены 
просто в виде списка. Очень часто в процессе работы требуется 
сгруппировать задачи или ресурсы иным способом. Для этого и 
предназначены команды группировки. 

Набор настроек параметров группировки называется группой. MS 
Project содержит набор предопределенных групп для задач и ресурсов. Кроме 
того, в программе существуют средства для настройки предопределенных 
групп и создания новых. 

Работа с командами группировки осуществляется через подменю 
Project > Group by: (Проект > Группировка). В нем (рис. 3.12) приводится 
список групп, доступных для открытой в представлении таблицы, и 
содержатся дополнительные команды для работы с полным списком групп 
MS Project. 

 

 
 

Рис. 3.12. Меню для работы с командами группировки 
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ПРИМЕЧАНИЕ: Помимо меню список доступных групп расположен в 
раскрывающемся списке на панели инструментов Standard (Стандартная). 
В списке на панели приведены названия всех групп, а в меню — только те, в 
параметрах которых установлен соответствующий флажок. 

После включения группировки название выбранной группы 
отображается в подменю Project > Group by: (Проект > Группировка). 
Например, в нашем случае пункт Group by: (Группировка) примет вид Group 
by: Critical (Группировка: Критические задачи). Для отключения 
группировки в подменю Project > Group by: (Проект > Группировка) нужно 
выбрать пункт No Group (Нет группы). 

3.3.1. Настройка параметров группировки 

Группировать данные можно как с помощью предопределенных 
групп, так и «на лету», самостоятельно выбирая параметры группировки. Для 
этого существует диалоговое окно Customize Group By (Настройка 
группировки), вызываемое с помощью соответствующего пункта в подменю 
Project > Group by: (Проект > Группировка). Это диалоговое окно (рис. 3.13) 
позволяет задать собственные параметры группировки (если в момент вызова 
диалогового окна был выбран пункт No Group (Нет группы)) либо 
отредактировать параметры группы, выбранной в момент его вызова. 

 

 
 

Рис. 3.13. Диалоговое окно настройки параметров группировки 
 

Основной элемент этого диалогового окна — таблица в верхней части, 
определяющая поля, по которым будет проводиться группировка. В столбце 
Field Name (Имя поля) указывается имя поля, по которому будет 
осуществляться группировка, а в столбце Order (Порядок) — как будут 
расположены группы: по возрастанию значений (Ascending) или по 
убыванию (Descending). 

Поле Field Type (Тип поля) заполняется автоматически и его значение 
несет информацию о том, к ресурсу (Resource) или задаче (Task) относится 
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поле. Это сделано для того, чтобы различать поля с одинаковыми именами из 
разных «внутренних» таблиц. 

В MS Project возможно осуществлять вложенную группировку, когда 
внутри одной группы может быть несколько других. В этом случае при 
задании полей группировки поля, расположенные в таблице выше, будут 
соответствовать группам верхнего уровня, содержащим группы, созданные 
на основе расположенных ниже в таблице полей. 

Участвуют фазы проекта в группировке задач или нет, зависит от 
состояния флажка Show summary tasks (Показывать фазы). Поскольку в 
нашем случае фазы будут только мешать, не будем устанавливать этот 
флажок (по умолчанию он сброшен). 

3.3.2. Создание и редактирование групп 

Самый простой путь создать собственную группу для последующего 
использования — сохранить параметры группировки, настроенные 
описанным в предыдущем разделе способом. 

Для сохранения группы на основе настроенных параметров нужно 
открыть диалоговое окно настройки параметров группировки с помощью 
команды меню Project > Group by: > Customize Group By (Проект > 
Группировка > Настройка группировки), а затем нажать в нем кнопку Save 
(Сохранить). В открывшемся окне (рис. 3.14) нужно указать название новой 
группы и определить, будет ли оно отображаться в подменю Project > Group 
by: (Проект > Группировка), установив или сбросив флажок Show in menu 
(Показывать в меню). 

 

 
 

Рис. 3.14. Диалоговое окно сохранения новой группы 
 
После того как вы нажмете кнопку ОК, группа будет сохранена и 

данные в таблице можно будет группировать в соответствии с настройками 
ее параметров. 

Для создания группы на основе существующей нужно выбрать 
команду меню Project > Group by: (Проект > Группировка), затем перейти в 
режим настройки параметров группировки с помощью команды меню Project 
> Group by: > Customize Group By (Проект > Группировка > Настройка 
группировки) и далее сохранить изменения. 

Для редактирования группы нужно открыть диалоговое окно со 
списком всех групп (рис. 3.15) командой Project > Group by: > More Groups 
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(Проект > Группировка > Другие группы), выбрать нужную группу и нажать 
кнопку Edit (Изменить). После этого откроется диалоговое окно определения 
параметров группы, представляющее собой расширенную версию окна 
определения параметров группировки. 

 

 
 

Рис. 3.15. Диалоговое окно со списком групп устроено по аналогии со 
списками таблиц и фильтров 

 
Диалоговое окно редактирования свойств группы отличается 

наличием поля для редактирования названия группы (Name) и флажка Show 
in menu (Показывать в меню), определяющего, будет ли группа отображаться 
в подменю Project > Group by: (Проект > Группировка). 
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Лабораторная работа № 4  

ДИАГРАММЫ 

Задание для выполнения работы 

1. Найдите диаграмму в представлении Gantt Chat (Диаграмма 
Ганта) в файле 1.mрр.  

2. Отформатируйте диаграмму Ганта в файле 1.mрр таким образом, 
чтобы длина отрезка, обозначающего процент выполнения задачи, у всех 
задач (даже не завершенных) равнялась длине отрезка, обозначающего 
задачу. Таким образом, в результате выполнения задания все задачи будут 
выглядеть как завершенные.  

3. Отформатируйте шкалу времени так, чтобы единицей измерения 
на верхнем уровне были кварталы, на среднем — 3 недели, и на нижнем — 3 
дня.  

4. Примените автоматическое масштабирование, чтобы отобразить 
в одном окне весь план проекта из файла 1.mрр.  

5. Отформатируйте диаграмму так, чтобы рядом с отрезками 
отображались затраты на выполнение работ, а над ними — трудозатраты.  

6. Скройте связи между задачами.  
7. С помощью Мастера диаграмм Ганта (GanttChartWizard) верните 

формат диаграммы к стандартному варианту.  
8. Создайте новую задачу с помощью мыши. Удалите созданную 

задачу.  

Контрольные вопросы 

1. Что такое диаграмма Ганта и из каких элементов она состоит.  
2. Какие подвиды диаграммы Ганта включены в MS Project и для 

чего они предназначены.  
3. Как определять форму и цвет отрезков диаграммы и 

отображаемую рядом с ними информацию для отдельного отрезка и их 
группы.  

4. Как форматировать шкалу времени «вручную» и с помощью 
средств автоматизированного масштабирования.  

5. Как использовать вспомогательные линии.  
6. Как настраивать дополнительные параметры диаграммы: способ 

отображения зависимостей между задачами, округление длительности задач 
и пр.  

7. Как использовать мастер диаграммы Ганта для 
автоматизированного форматирования диаграммы.  

8. Как редактировать проектные данные на диаграмме Ганта.  
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4.1. Диаграмма Ганта 

Диаграмма Ганта — это один из наиболее популярных способов 
графического представления плана проекта, применяемый во многих 
программах управления проектами. 

В MS Project диаграммы являются не только средством просмотра 
проектной информации. С помощью диаграмм можно вводить новые данные 
и редактировать существующие 

Диаграмма Ганта названа в честь Генри Ганта (1861-1919), соратника 
«отца научного менеджмента» Фредерика Тейлора (1856-1915). Гант изучал 
менеджмент на примере постройки кораблей во время Первой мировой 
войны и предложил свою диаграмму, состоящую из отрезков (задач) и точек 
(завершающих задач, или вех), как средство для представления длительности 
и последовательности задач в проекте. Диаграмма Ганта оказалась таким 
мощным аналитическим инструментом, что в течение почти ста лет не 
претерпевала изменений. И лишь в начале 1990-х для более подробного 
описания взаимосвязей в нее были добавлены линии связи между задачами. 

ПРИМЕЧАНИЕ: Все элементы диаграммы Ганта в MS Project 
являются настраиваемыми отрезками, каждый из которых может 
состоять из трех элементов: точки начала, точки окончания и 
промежуточной части (при этом любой из элементов может 
отсутствовать). При стандартной настройке отрезки, обозначающие 
фазы, содержат все три элемента (рис. 4.1). Отрезки, обозначающие 
задачи, состоят только из промежуточной части, а завершающие задачи — 
только из начальной точки. Далее в этом уроке мы рассмотрим, как эти 
настройки можно изменить. 

 

 
 

Рис. 4.1. Основные элементы диаграммы Ганга. Задача и 
завершающая задача соединены связью, обозначающей,  

что задача 3 следует после задачи 2 
 

В MS Project диаграмма Ганта (Gantt Chart) является основным 
средством визуализации плана проекта. Эта диаграмма представляет собой 
график, на котором по горизонтали размещена шкала времени, а по 
вертикали расположен список задач (рис. 4.2). При этом длина отрезков, 
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обозначающих задачи, пропорциональна длительности задач. При наведении 
мыши на любой элемент диаграммы отображается всплывающая подсказка. 

На диаграмме Ганта рядом с отрезками может отображаться 
дополнительная информация (например, на рис. 4.2 рядом с задачами 
отображаются названия задействованных в них ресурсов и их загрузка при 
выполнении задачи). Ее состав определяется настройками диаграммы, и в MS 
Project входят несколько заранее настроенных версий диаграммы Ганта, на 
которых рядом с отрезками отображается различная информация (табл. 4.1). 

 

 
 

Рис. 4.2. Диаграмма Ганта в MS Project 
 

Таблица 4.1  
Диаграммы MS Project, производные от диаграммы Ганта 

 

Название диаграммы Описание 

1 2 
Detail Gantt 
(Подробная 
диаграмма Ганта)  

Диаграмма используется при оптимизации плана 
проекта, когда требуется равномерно распределять 
нагрузку между ресурсами. На диаграмме 
отображаются возможные периоды времени, на 
которые выполнение задачи можно отложить без 
изменения срока окончания проекта  

Leveling Gantt 
(Диаграмма Ганта с 
выравниванием)  

Диаграмма используется для выравнивания нагрузки 
ресурсов (resource leveling). На ней отображаются все 
изменения, осуществленные в процессе 
выравнивания  
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Окончание табл. 4.1 
1 2 

Tracking Gantt 
(Диаграмма Ганта с 
отслеживанием)  

Диаграмма используется для сравнения 
запланированных сроков выполнения проекта и 
реальных в процессе выполнения проектных 
работ. Для каждой задачи и фазы на диаграмме 
отображается запланированный срок выполнения 
и реальный  

Multiple Baselines Gantt 
(Диаграмма Ганта с 
несколькими планами)  

Диаграмма используется для сравнения первых 
трех базовых планов проекта  

PA_Expected Gantt 
(Диаграмма Ганта с 
ожидаемым планом 
проекта)  

Диаграммы предназначены для анализа плана 
работ с помощью метода PERT (PERT Analysis, 
или сокращенно РА).  

PA_Optimistic Gantt 
(Диаграмма Ганта с 
оптимистичным планом 
проекта)  
PA_Pessimistic Gantt 
(Диаграмма Ганта с 
пессимистичным планом 
проекта)  

Поскольку метод заключается в построении трех 
планов (реалистичного, пессимистичного и 
оптимистичного) и их дальнейшем анализе, то для 
работы с ним используются три диаграммы  

 
Может получиться так, что вам понадобится изменить стандартную 

диаграмму Ганта или ее версию. В этом случае нужно воспользоваться 
возможностями форматирования диаграммы. 

4.1.1. Форматирование диаграммы Ганта 

В MS Project содержится большой набор средств для форматирования 
диаграммы Ганта. Они позволяют: 

• изменять форму и цвет составляющих диаграмму фигур;  
• определять, какая проектная информация отображается на 

диаграмме рядом с фигурами;  
• отображать дополнительную графическую информацию 

(отклонение от базового плана и пр.);  
• форматировать шкалу времени (тем самым уменьшая или 

увеличивая масштаб отображения плана проекта).  
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4.1.2. Настройка формы и цвета отрезков 

Настройка формы и цвета элементов диаграммы определяется в 
диалоговом окне форматирования отрезков. Открывается оно после двойного 
щелчка на элементе диаграммы, который требуется отформатировать (рис. 4.3). 

 
 

Рис. 4.3. Диалоговое окно форматирования отрезка 

4.1.3. Настройка текстовой информации, 
 отображаемой рядом с отрезком 

Рядом с отрезком можно отображать разнообразную текстовую 
информацию. Чтобы определить, какая текстовая информация будет 
выведена рядом с той или иной фигурой диаграммы, нужно щелкнуть на ней 
два раза и в открывшемся (уже знакомом нам) диалоговом окне 
форматирования элемента диаграммы перейти на вкладку Bar Text (Текст 
отрезка) (рис. 4.4). 

 

 
 

Рис. 4.4. На вкладке Bar Text (Текст отрезка) можно определить, какая 
текстовая информация будет отображаться рядом с отрезком 

 
Часто приходится форматировать внешний вид сразу всех задач плана 

или задач определенного типа (например, завершающих). В таком случае 
стоит воспользоваться приемами группового форматирования отрезков. 
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4.1.4. Групповое форматирование элементов диаграммы 

Групповое форматирование элементов диаграммы позволяет 
полностью настраивать вид диаграммы, определяя, какая именно 
информация из проектного файла и каким образом отображается на 
диаграмме. Для этого в диалоговом окне определяются типы (или стили) 
отрезков. Каждый стиль соотносится с определенным типом задач и имеет 
свои параметры представления на диаграмме. 

Диалоговое окно группового форматирования (рис. 4.5) вызывается с 
помощью команды меню Format > Bar Styles (Формат > Стили отрезков). Оно 
состоит из двух основных разделов. Верхний раздел содержит таблицу, в 
которой определяются отображаемые на диаграмме типы отрезков. Нижний 
раздел содержит две вкладки с параметрами, определяющими внешний вид 
типов отрезков, указанных в верхнем разделе. 

 

 
 

Рис. 4.5. Диалоговое окно группового форматирования отрезков со 
стандартными настройками диаграммы Ганта 

 

4.1.5. Форматирование шкалы времени 

Чтобы задачи отображались на диаграмме в удобном масштабе, в 
диалоговом окне форматирования временной шкалы нужно изменить 
используемые единицы измерения. Это диалоговое окно вызывается из 
подменю Format > Timescale (Формат > Шкала времени) или через 
контекстное меню временной шкалы с помощью команды Timescale (Шкала 
времени). Оно состоит из четырех вкладок (рис. 4.6) — Top Tier (Верхний 
уровень), Middle Tier (Средний уровень), Bottom Tier (Нижний уровень) и 
Non-working Time (Нерабочее время). 

Шкала времени в диаграмме Ганга состоит из трех уровней — 
верхнего, среднего и нижнего, из которых обязателен только средний. 
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Название уровня указывает на порядок отображения на временной шкале: 
нижний уровень отображается под средним, а средний — под верхним. 

Каждый из уровней содержит единицы измерения, при этом единицы 
уровня, расположенного ниже, должны быть не больше единиц более 
высокого уровня. Например, если средний уровень разделен на месяцы, то 
нижний должен быть разделен на месяцы, недели, дни, часы или минуты, но 
не года. На рис. 4.6, например, в нижней части диалогового окна представлен 
образец временной шкалы, на которой единицей измерения верхней шкалы 
является день, а нижней — 2 часа. 

 

 
 

Рис. 4.6. На вкладке Timescale (Шкала времени) осуществляется 
настройка единиц измерения, используемых временной шкалой; 

настраиваемая шкала видна в разделе Preview (Образец) 
 

СОВЕТ: Для быстрого изменения формата временной шкалы (без 
вызова окна Zoom (Масштаб)) стоит воспользоваться кнопками Zoom In 
(Увеличить) и Zoom Out (Уменьшить), расположенными на панели 
инструментов Standard (Стандартная). Первая кнопка, представленная 
лупой со значком «+», заменяет единицы измерения более мелкими 
(например, недели на дни), увеличивая детализацию. Вторая, представленная 
кнопкой со значком «-», уменьшает детализацию, заменяя единицы 
измерения на более крупные (например, дни на недели). 

4.1.6. Вспомогательные линии 

Большие диаграммы сложно просматривать без вспомогательных 
линий. Вертикальные вспомогательные линии позволяют быстро соотнести 
отрезок с временной шкалой, а горизонтальные линии — с задачей в списке. 
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По умолчанию на диаграмме отображаются только вертикальные 
линии, отделяющие недели друг от друга (см. рис. 4.6), но зачастую для 
удобства просмотра диаграммы требуется отобразить и другие линии. 

Для настройки параметров отображения вспомогательных линий 
нужно открыть диалоговое окно Gridlines (Сетка), выбрав команду меню 
Format > Gridlines (Формат > Сетка) или команду Gridlines (Сетка) 
контекстного меню диаграммы. Диалоговое окно форматирования сетки 
(рис. 4.7) состоит из списка возможных линий (табл. 4.2) и списка 
настраиваемых для каждой из них параметров. Нужно выбрать линию из 
списка и затем настроить параметры ее отображения. 

 

 
 

Рис. 4.7. Диалоговое окно форматирования сетки диаграммы 
 

Таблица 4.2 
Линии, отображаемые на диаграмме Ганта 

 

Название линии Описание 

1 2 
Gantt Rows (Строки 
диаграммы Ганта)  

Горизонтальные линии на диаграмме, 
соответствующие линиям между названиями задач в 
сопутствующей диаграмме таблице  

Bar Rows (Строки 
отрезков)  

Горизонтальные линии на диаграмме, 
отображающиеся между несколькими отрезками для 
одной задачи (если такой режим был выбран при 
настройке стилей отрезков)  

Major Columns 
(Линия раздела 
среднего уровня)  

Вертикальные линии, соответствующие границам 
между единицами измерения на среднем уровне 
временной шкалы  

Minor Columns 
(Линия раздела 
нижнего уровня)  

Вертикальные линии, соответствующие границам 
между единицами измерения на нижнем уровне 
временной шкалы  
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Окончание табл. 4.2 
1 2 

Current Date (Текущая 
дата)  

Вертикальная линия, соответствующая текущей 
дате  

Sheet Rows (Строки 
листа)  

Линии, разделяющие строки сопутствующей 
диаграмме таблицы  

Sheet Columns (Столбцы 
листа)  

Линии, разделяющие колонки сопутствующей 
диаграмме таблицы  

Title Vertical 
(Вертикальные в 
заголовке)  

Вертикальные линии, разделяющие единицы 
временной шкалы  

Title Horizontal 
(Горизонтальные в 
заголовке)  

Горизонтальные линии, разделяющие единицы 
временной шкалы  

Page Breaks (Разрывы 
страниц)  

Линии, соответствующие разрыву страниц при 
печати  

Project Start (Начало 
проекта)  

Вертикальная линия, соответствующая дате 
начала проекта  

Project Finish (Окончание 
проекта)  

Вертикальная линия, соответствующая дате 
завершения проекта  

Status Date (Дата отчета о 
состоянии)  

Вертикальная линия, соответствующая дате 
отчета о состоянии проекта  

Top Tier (Линия раздела 
верхнего уровня)  

Вертикальные линии, соответствующие 
границам между единицами измерения на 
верхнем уровне временной шкалы  

 
Форматирование линий заключается в определении двух свойств: 

Туре (Тип) и Color (Цвет). Тип определяет, какой вид будет иметь линия 
(сплошная, пунктирная и т. п.). Кроме того, в списке вариантов типов 
содержится пункт без линии (см. рис. 4.7). Его выбор уберет линию с 
диаграммы. 

Некоторые линии могут выводиться с определенным интервалом, и 
при их редактировании становится активным раздел настроек At interval (С 
интервалом). В нем можно определить интервал, с которым будет 
отображаться линия, а также ее цвет и тип. 

4.1.7. Настройка дополнительных параметров диаграммы 

Настройка параметров диаграммы не ограничивается определением 
параметров отображения отрезков на ней. Диалоговое окно Layout (Макет) 
позволяет определить некоторые ее дополнительные свойства, общие для 
всех размещенных на ней отрезков. 
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Данное диалоговое окно (рис. 4.8) вызывается командой меню Format 
> Layout (Формат > Макет) или командой Layout (Макет) контекстного меню 
диаграммы Ганта. 

 

 
 

Рис. 4.8. Диалоговое окно определения общих параметров 
диаграммы Ганта 

4.1.8. Мастер диаграмм Ганта 

Для быстрой настройки многочисленных параметров диаграммы в MS 
Project входит специальный компонент — Мастер диаграмм Ганта 
(GanttChartWizard). Мастер вызывается командой меню Format > 
GanttChartWizard (Формат > Мастер диаграмм Ганта) или с помощью 
команды GanttChartWizard (Мастер диаграмм Ганта) в контекстном меню 
диаграммы Ганта. Кроме того, для вызова мастера служит крайняя правая 
кнопка на панели инструментов Formatting (Форматирование). 

Работа мастера состоит из нескольких шагов, на которых нужно 
последовательно определять основные параметры настраиваемой диаграммы. 
Для перемещения между шагами используются кнопки Back (Назад) и Next 
(Вперед). На любом из шагов (начиная со второго) мастера можно прервать и 
завершить настройку диаграммы, нажав кнопку Finish (Завершить). 

Первый шаг содержит приветствие и его можно пропустить. На 
втором шаге (рис. 4.9) нужно определить, какая информация будет 
отображаться на диаграмме. Мастер предлагает три основных варианта: 
Standart (Стандартная) соответствует обычному формату диаграммы, 
используемому при создании нового проекта; Critical Path (Критический 
путь) отображает обычную диаграмму, на которой критические задачи 
выделены цветом; Baseline (Исходный план) отобразит диаграмму с 
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совмещением отрезков, соответствующих исходному плану, и отрезков, 
отображающих фактический ход работ. 

 
 

Рис. 4.9. Второй шаг настройки диаграммы Ганта с помощью мастера: 
выбираем отображаемую информацию 

 
В раскрывающемся списке Other (Другие) содержатся 

дополнительные версии первых трех вариантов настройки диаграммы. 
Отличаются они графическими элементами, использованными для 
оформления отрезков. В окне предварительного просмотра будут 
отображаться основные элементы диаграммы, что дает возможность 
получить представление о том, как она будет выглядеть. Например, на 
рис. 4.9 в окне предварительного просмотра можно увидеть, как будет 
выглядеть диаграмма Ганта при применении варианта Status 1 (Состояние: 
стиль 1). Наконец, переключатель Custom Gantt Chart (Настроить диаграмму 
Ганта) служит для перехода в режим детальной настройки параметров 
диаграммы. В этом режиме вы должны будете самостоятельно определить 
тип отображаемой на диаграмме информации, форму и цвет отрезков, и 
формат отображаемой текстовой информации. 

Параметры, настраиваемые на дальнейших шагах мастера, не должны 
вызывать затруднений, поскольку повторяют параметры, присутствующие в 
трех диалоговых окнах форматирования диаграммы, рассмотренных выше. 

Удобство работы с мастером заключается в том, что для отображения 
на диаграмме нового типа информации (например, о базовом плане) вам 
достаточно выбрать соответствующий параметр, например Standard 
(Стандартная), и нажать кнопку Finish (Завершить). Отображение такой 
информации с помощью средств группового форматирования элементов 
занимает существенно больше времени. С другой стороны, диалоговые окна 
группового форматирования и настройки дополнительных параметров 
позволяют настраивать свойства диаграммы, недоступные при работе с 
мастером. 
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4.1.9. Редактирование проектных данных на диаграмме Ганта 

Диаграмма Ганта дает возможность не только просматривать 
проектную информацию в удобном формате, но и редактировать ее, причем 
особенно удобны возможности редактирования с помощью мыши. 

Для изменения даты начала и окончания задач нужно навести мышь 
па середину отрезка, чтобы курсор принял форму креста с четырьмя 
стрелками, и перетащить ее вправо или влево 1. Чтобы увеличить или 
уменьшить длительность задачи, нужно подвести курсор к правому краю 
отрезка, чтобы он принял вид полосы со стрелкой вправо, и перетащить край 
отрезка вправо или влево. А если подвести курсор к левому краю задачи, то 
он примет вид полосы со знаком процента, и перетаскивая его можно 
определить процент выполнения задачи. 

Для связи задач друг с другом достаточно навести курсор на середину 
отрезка исходной задачи и, когда он примет вид креста со стрелками, 
потащить курсор к другой задаче. По мере продвижения курсора за ним 
будет тянуться линия («связь») — ее нужно «бросить» на отрезок задачи, с 
которой связывается исходная. Редактировать связь можно с помощью 
диалогового окна, открывающегося после двойного щелчка на связи 
(рис. 4.10). В раскрывающемся списке Туре (Тип) можно выбрать тип связи, 
а в счетчике Lag (Запаздывание) — временной интервал между связанными 
задачами. Кнопка Delete (Удалить) удаляет связь. 

Программа не даст перемещать выполненные задачи. 
 

 
 

Рис. 4.10. Диалоговое окно редактирования связи на диаграмме Ганга 
 
Наконец, на диаграмме Ганта можно прервать задачу (когда работа 

требует перерыва, например, если исполнитель задачи заболел), причем это 
единственный способ осуществления операции прерывания. Для этого нужно 
щелкнуть правой кнопкой мыши на отрезке задачи и в контекстном меню 
выбрать команду Split Task (Прервать задачу). После этого нужно установить 
курсор в точку отрезка, с которой начнется перерыв, и тащить его вправо. 
Задача разделится на две составляющие, соединенные точками (рис. 4.11). 
Для отмены разделения нужно перетащить одну из частей задачи вплотную к 
другой, и отрезки снова станут единым целым. 
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Рис. 4.11. В центре рисунка расположена прерванная задача,  
перерыв отмечен точками 

 
С помощью контекстного меню, появляющегося при щелчке правой 

кнопкой на отрезке задачи, можно попасть в диалоговое окно определения 
свойств задачи, Task Information (Сведения о задаче). В этом окне можно 
редактировать все свойства задачи. 

4.2. Диаграмма использования задач 

Диаграммы использования задач и ресурсов в большей степени, чем 
остальные, применяются для ввода повременных данных в файл проекта. 
Знать возможности этих диаграмм и уметь работать с ними очень важно, 
поскольку без их помощи невозможно ввести в план проекта повременные 
данные, например, указать, что в первый день работы над задачей сотрудник 
работает 1 час, а во второй день — 2 часа. 

Диаграмма Task Usage (Использование задач) предназначена для 
анализа участия ресурсов в проектных работах. В таблице, размещенной 
рядом с диаграммой, отображается план проекта, в котором под каждой из 
задач приведен список задействованных в ней ресурсов (рис. 4.12). 
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Рис. 4.12. Диаграмма использования задач 
 

Сама диаграмма представляет собой таблицу, в строках которой 
размещена информация о фазах, задачах и ресурсах. Внутри строки данные 
размещены и ячейках в соответствии с датами, к которым они 
относятся.Таким образом, диаграмма позволяет получать разнообразные 
данные о работе (объем работы, стоимость, загрузка ресурсов и пр.) за 
произвольный временной период для проекта в целом, любой из его фаз, 
задач или задействованного в выполнении задачи ресурса.  
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Лабораторная работа № 5 

СЕТЕВЫЕ ГРАФИКИ В MS PROJECT 

Задание для выполнения работы 

1. С помощью панели инструментов для работы с сетевым 
графиком примените к графику, отформатированному вручную, параметры 
автоматического форматирования (график находится в файле 1.mрр).  

2. Расположите график по центру сверху.  
3. С помощью контекстного меню верните графику стандартный 

размер.  
4. Измените формат графика таким образом, чтобы некритические 

задачи отображались в овале.  
5. Отформатируйте график так, чтобы при применении фильтра в 

режиме выделения подсвеченные блоки изменяли не только цвет, но и 
форму.  

6. Создайте новый шаблон для блоков. В этом шаблоне обязательно 
должна содержаться информация о длительности задачи (Duration), 
трудозатратах (Work) и ее затратах (Cost).  

7. Отформатируйте график так, чтобы при применении фильтра в 
режиме выделения у подсвеченных блоков шаблон изменялся на тот, что был 
создан в предыдущем задании.  

8. Откройте представление Descriptive Network Diagram (Сетевой 
график с описанием) и отформатируйте его аналогичным образом, используя 
ранее созданный шаблон блока.  

9. Добавьте новую задачу с помощью мыши. Удалите созданную 
задачу.  

Контрольные вопросы 

1. Что такое сетевой график.  
2. Какие виды сетевых графиков включены в MS Project, для чего 

они предназначены и чем отличаются друг от друга.  
3. Как изменять формат отдельного блока сетевого графика и их 

группы.  
4. Что такое шаблон блока, как его создать и отформатировать.  
5. Как устанавливать параметры расположения блоков на графике.  
6. Как после ручного позиционирования блоков вернуться к их 

размещению, характерному для режима автоматического позиционирования.  
7. Как масштабировать график.  
8. Как быстро настраивать график с помощью панели инструментов 

Network Diagram (Сетевой график).  
9. Как редактировать проектные данные на сетевом графике.  
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5.1. Виды сетевых графиков в MS Project 

Сетевой график, или блок-схема, — не менее популярное средство 
визуализации плана проекта, чем диаграмма Ганта. Не случайно в MS Project 
имеется три вида сетевых графиков. 

В MS Project есть три графика, которые можно отнести к сетевым: это 
собственно Network Diagram (Сетевой график), Descriptive Network Diagram 
(Сетевой график с описанием) и Relationship Diagram (Схема данных) (Этот 
перевод, видимо, сделан по аналогии с реляционными СУБД. На наш взгляд, 
более точным будет перевод «Диаграмма зависимостей», так как диаграмма 
предназначена для анализа взаимосвязей между задачами). 

Отличие сетевого графика с описанием от стандартного сетевого 
графика заключается только в повышенной информативности блоков: по 
умолчанию на них отображается больше информации. Поэтому все приемы, 
описанные в следующем разделе, относятся в полной мере и к сетевому 
графику с описанием. Нет приемов для работы с графиком с описанием, 
которые бы не могли быть применены к стандартному сетевому графику. 

Принцип построения и внешний вид схемы данных отличается от 
первых двух графиков. Разница состоит в том, что на первых двух графиках 
можно сразу просматривать информацию обо всем плане проекта, а на схеме 
данных — только об одной задаче из этого плана. Поэтому данной 
диаграмме, в отличие от сетевого графика с описанием, мы посвятили целый 
раздел этого урока. 

5.1.1. Форматирование сетевого графика 

В MS Project включен большой набор средств по форматированию 
сетевого графика, и эти средства позволяют изменять как оформление его 
блоков, так и состав отображаемой в них информации. 

Принципы форматирования сетевого графика не отличаются от 
принципов форматирования диаграммы Ганта: можно отформатировать 
отдельный элемент графика, группу элементов и настроить дополнительные 
параметры группы. 

5.1.2. Форматирование блока 

Чтобы отформатировать блок, нужно щелкнуть на нем, а затем 
открыть диалоговое окно форматирования (рис. 5.1), выбрав команду меню 
Format > Box (Формат * Рамка) или команду Format Box (Формат рамки) в 
контекстном меню блока. 

http://www.taurion.ru/project/5/2


 66

 
 

Рис. 5.1. Диалоговое окно со списком всех шаблонов данных 

5.1.3. Настройка дополнительных параметров  

Сетевой график фактически представляет собой таблицу, в ячейках 
которой расположены блоки (при этом границы ячеек таблицы не 
отображаются). Параметры отображения блоков внутри этой таблицы и связи 
их друг с другом определяются в диалоговом окне Layout (Макет) (рис. 5.2), 
вызываемом командой меню Format > Layout (Формат > Макет) или при 
помощи команды Layout (Макет) в контекстном меню графика. 

 

 
 

Рис. 5.2. Диалоговое окно с параметрами оформления сетевого 
графика 

http://www.taurion.ru/project/5/2
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Это диалоговое окно содержит намного больше элементов, чем 

аналогичное окно для диаграммы Ганта. Первая группа параметров, Layout 
Mode (Режим расположения рамок), определяет, будут ли блоки 
располагаться на графике только автоматически или MS Project будет 
позволять перемещать их «вручную». Для первого режима работы нужно 
выбрать переключатель Automatically position all boxes (Располагать все 
рамки автоматически), а для второго — Allow manual box positioning 
(Разрешить располагать рамки вручную). 

Вторая группа параметров, Box Layout (Расположение рамок), 
определяет, как будут размещены блоки на графике. В раскрывающемся 
списке Arrangement (Расположение) выбирается вариант ориентации блок-
схемы на графике. 

При выборе пункта списка Top Down From Left (Сверху вниз слева) 
первая задача будет расположена в верхнем левом углу и станет началом 
блок-схемы. В этом случае расположение блоков относительно друг друга 
определяется логической последовательностью задач. Это стандартный 
принцип построения сетевого графика (рис. 5.3). 

 

 
 

Рис. 5.3. Так выглядит план проекта на сетевом графике, 
скомпонованном сверху вниз из верхнего левого угла 

 
При выборе следующих пунктов — Top Down By Day (Сверху вниз по 

дням), Top Down By Week (Сверху вниз по неделям), Top Down By Month 
(Сверху вниз по месяцам) — блоки располагаются аналогично предыдущему 
случаю, но с учетом момента начала выполнения задач. Задачи, 
начинающиеся в один и тот же период (день, неделю или месяц — в 
зависимости от графика), отображаются в одной колонке друг под другом. 

Пункт Top Down Critical First (Сверху вниз, сначала критические) 
строит блок-схему таким образом, что блоки, обозначающие критические 
задачи, располагаются ближе к началу схемы, чем в стандартном, первом 
варианте. 

Пункт Centered From Left (По центру слева) размещает первую задачу 
в крайней левой колонке так, чтобы она находилась на центральной линии 
блок-схемы, блоки которой располагаются вправо от первой задачи, вверх и 
вниз (рис. 5.4). 
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Рис. 5.4. Так выглядит сетевой график при компоновке его от центра 
левой стороны 

 
Пункт Centered From Top (По центру сверху) отображает первую 

задачу в центре верхнего ряда диаграммы, а блок-схема располагается вниз 
от первой задачи, вправо и влево (рис. 5.5). 

 

 
 

Рис. 5.5. Вид сетевого графика  
при компоновке его сверху вниз от центра 

 
В строках Row (Строки) и Column (Столбцы) собраны параметры, 

определяющие, как блоки располагаются внутри невидимых рядов и колонок 
сетевого графика. В раскрывающемся списке Alignment (Выравнивание) 
можно выбрать ориентацию блока внутри ряда или колонки: Center (По 
центру), Тор (По верхнему краю), Bottom (По нижнему краю), Left 
(Полевому краю), Right (По правому краю). Параметр Spacing (Интервал) 
определяет интервал между рядами и колонками. Наконец, в 
раскрывающихся списках Height (Высота) и Width (Ширина) определяется, 
будут ли на графике все колонки или ряды фиксированной ширины и высоты 
или высота и ширина будут подбираться с учетом данных, размещенных на 
графике. Для включения первого режима используется значение списка Fixed 
(Фиксированная), а для второго — Best Fit (Автоподбор). 
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Флажок Show summary tasks (Показывать суммарные задачи) 
определяет, будут ли на графике отображаться блоки, соответствующие 
фазам плана проекта. Флажок Keep tasks with their summaries (He отрывать 
задачи от их суммарных задач) управляет группировкой задач по фазам. 
Например, в режиме отображения Top Down From Left (Сверху вниз слева) 
при установленном флажке задачи будут находиться в одной строке таблицы 
с фазой, а если этот флажок сброшен, то там, где следует по логике проекта. 
Флажок Adjust for page breaks (Учитывать разрывы страниц) определяет, 
будут ли блоки автоматически переноситься так, чтобы не попадать на 
разрывы страниц. 

Вид связей между блоками определяется в разделе Link style (Стиль 
линий связи). С помощью переключателей Rectilinear (Прямоугольные) и 
Straight (Прямые) можно выбрать прямоугольные или прямые линии связи. 
Состоянием флажка Show arrows (Показывать стрелки) задается наличие 
стрелок в конце линий связи между блоками, а флажок Show link labels 
(Показывать надписи для связей) позволяет отобразить над связями значки с 
указанием типа связи. 

На рис. 5.6 представлен сетевой график, на котором использованы 
некоторые из описанных настроек. График скомпонован сверху вниз от 
центра, установлен флажок отображения информации о связях, из-за чего над 
ними появились прямоугольники с текстовой информацией. Флажок Keep 
tasks with their summaries (He отрывать задачи от их суммарных задач) 
сброшен. Именно поэтому задачи, относящиеся ко второй фазе проекта, 
отображаются в колонке под первой фазой. 

 

 
 

Рис. 5.6. Сетевой график с компоновкой сверху вниз 
от центра с дополнительными настройками 
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В разделе Link color (Цвет линий связи) определяется, какой цвет 

будут иметь связи между блоками. Если выбрать переключатель Match 
predecessor box border (В соответствии с цветом рамки предшественника), то 
цвет связи всегда будет повторять цвет блока задачи, от которой эта связь 
отходит. Если же выбрать другой переключатель, то связи всегда будут 
иметь те цвета, которые выбраны в раскрывающихся списках Critical links 
(Критические связи) и Noncritical links (Некритические связи). 

В разделе Diagram Options (Параметры диаграммы) расположены 
параметры отображения графика в целом. Раскрывающиеся списки 
Background color (Цвет фона) и Background pattern (Фоновый узор) 
определяют цвет и заливку фона графика. Флажок Show page breaks 
(Показывать разрывы страниц) управляет отображением границ страниц на 
графике. Флажок Mark in-progress and completed (Помечать завершенные и 
находящиеся в процессе выполнения задачи) включает выделение задач, 
находящихся в процессе выполнения или завершенных. Наконец, флажок 
Hide all fields except ID (Скрыть все поля, кроме идентификатора) позволяет 
убрать из блоков все поля, кроме их номера, что делает блоки очень 
маленькими и позволяет увидеть на графике сразу весь проект. 

ПРИМЕЧАНИЕ: Для быстрого изменения масштаба графика можно 
воспользоваться кнопками Zoom In (Увеличить) и Zoom Out (Уменьшить), 
расположенными на панели инструментов Standard (Стандартная). Первая 
кнопка, представленная лупой со значком «+», увеличивает размер блоков, 
вторая, представленная лупой со значком «-», уменьшает их. 

Если в процессе ручной настройки графика блоки расположились 
неудачно и хочется снова расположить их так, как они были расположены в 
автоматическом режиме размещения блоков, можно воспользоваться 
командой меню Format > Layout Now (Формат >Применить макет). Можно 
также выбрать команду Layout Now (Применить макет) в контекстном меню 
графика, в котором содержатся еще две команды для применения 
автоматического форматирования при включенном режиме ручного 
размещения блоков. 

Команда Layout Selection Now (Применить макет к выделенному 
фрагменту) предназначена для того, чтобы расположить в автоматическом 
режиме только выделенные блоки. А с помощью команды Layout Related 
Tasks Now (Применить макет к связанным задачам), отображаемой в 
контекстном меню блока графика (когда выделен только один блок), можно 
применить автоматическое расположение ко всем связанным с ним блокам. 

5.2. Схема данных 

Схема данных (Relationship Diagram) — это особый вид сетевого 
графика, предназначенный только для анализа связей между задачами 
проекта. 
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Диаграмма разделена на страницы, которые можно пролистывать с 
помощью полосы прокрутки. На одной странице можно просматривать 
информацию только об одной задаче, и страницы с задачами расположены по 
возрастанию порядкового номера задачи. 

Блок с информацией о задаче расположен в центре страницы (рис. 5.7) 
и выделен цветом. Слева от него расположены блоки предшествующих 
задач, а справа — последующих. Щелкнув на любом из этих блоков, можно 
сразу перейти на страницу диаграммы с информацией о соответствующей 
задаче. 

 

 
 

Рис. 5.7. Схема данных MS Project: в центре расположена текущая 
задача, выделенная цветом, слева — предшествующая задача,  

а справа — последующие 
 

Диаграмма не содержит элементов, предназначенных для 
форматирования блоков или настройки диаграммы в целом. Кроме того, с 
помощью диаграммы нельзя редактировать проектные данные — их можно 
только просматривать. 

Использовать эту диаграмму удобно для анализа плана проекта с 
множеством зависимостей, поскольку с ее помощью можно сфокусироваться 
на задачах, связанных с выбранной. При этом ее использование наиболее 
эффективно в сочетании с другими диаграммами или таблицами внутри вида. 
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Лабораторная работа № 6 

КАЛЕНДАРЬ И ГРАФИК РЕСУРСОВ 

Задание для выполнения работы 

1. Перейдите к задаче с идентификатором 3.  
2. В файле 1.mрр 19 января 2010 (суббота) является нестандартным 

рабочим днем для всех участников проекта. Отформатируйте календарь так, 
чтобы этот день (и другие нестандартные рабочие дни) были выделены 
цветом.  

3. Отформатируйте блок календаря таким образом, чтобы в углу 
каждого квадрата рядом с числом отображалось краткое название месяца.  

4. Настройте календарь так, чтобы на отрезках, обозначающих 
некритические задачи, отображалась информация о трудозатратах.  

5. Настройте календарь так, чтобы при фильтрации в режиме 
выделения задачи, отобранные фильтром, выделялись красным цветом.  

6. Выделите текст на всех критических задачах проекта курсивным 
начертанием.  

7. Отобразите в левой колонке названия недель.  
8. Отделите дни друг от друга красными вертикальными линиями, 

недели — синими горизонтальными.  
9. Добавьте новую задачу с помощью мыши. Удалите созданную 

задачу.  
10. В ресурсном графике в файле 1.mрр отобразите линию 

доступности ресурса.  
11. Включите режим отображения единиц измерения на 

горизонтальной шкале под отрезками.  
12. Выведите на диаграмме данные об объеме работ всех ресурсов и 

сравните их с данными для одного из них. При этом отобразите данные в 
представлении заполненных цветом областей.  

13. Измените представление с областей на отрезки.  
14. Настройте режим, при котором отрезки с трудозатратами ресурса 

и группы ресурсов будут частично пересекаться (например, на 10%).  
15. Измените оформление надписей шкалы диаграммы, легенды и 

временной шкалы.  
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Контрольные вопросы 

1. Что такое календарь и ресурсный график, для чего 
предназначены эти диаграммы и как с их помощью получать данные о 
проекте.  

2. Как определять, какие отрезки будут отображаться на календаре, 
какая информация будет на них отображаться и как настраивать их внешний 
вид.  

3. Как определять формат календаря, использовать фон ячеек, 
настраивать режим отображения дней.  

4. Как сортировать и оптимально размещать отрезки на календаре, 
использовать вспомогательные линии.  

5. Как редактировать с помощью календаря проектные данные и 
использовать встроенные в диаграмму сервисные функции.  

6. Как определять отображаемый на ресурсном графике тип данных, 
форму его представления и группы ресурсов, данные о которых 
отображаются.  

7. Как использовать временную шкалу, вспомогательные линии и 
настраивать используемые на ресурсном графике шрифты.  

8. Как редактировать данные с помощью ресурсного графика.  

6.1. Календарь 

Календарь — одна из основных диаграмм, которыми вы будете 
пользоваться при работе в MS Project, потому что с его помощью можно 
представить план работ в привычном для большинства сотрудников виде. В 
этом уроке вы узнаете, как настраивать отображение задач плана проекта на 
этой диаграмме. 

График ресурсов предназначен для анализа загрузки ресурсов. Вы 
узнаете, какую информацию можно получать с помощью этого 
представления и как его настраивать. Когда вы освоите тонкости работы с 
этим представлением, вы сможете получать все необходимые вам отчеты по 
ресурсам в рамках проекта. 

Диаграмма Календарь (Calendar) отображает информацию о плане 
проекта в виде таблицы с семью или пятью колонками, соответствующими 
дням недели, и множеством рядов, соответствующих неделям. Задачи на 
календаре обозначены отрезками, которые начинаются в день начала работ 
над задачей и заканчиваются в день их окончания (рис. 6.1). 
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Рис. 6.1. Диаграмма напоминает обычный календарь, на котором 
задачи отмечены отрезками, колонки соответствуют дням недели,  

а строки — неделям 
 

Диаграмма удобна тем, что представляет план проекта и задачи 
внутри него в традиционном календарном виде. MS Project содержит набор 
средств, позволяющих отформатировать календарь удобным способом, 
например чтобы его можно было распечатать и повесить на стену. Кроме 
того, на диаграмме можно редактировать план проекта. 

6.1.1. Форматирование календаря 

Принципы настройки календаря совпадают с принципами настройки 
диаграммы Ганта: можно отформатировать стили отрезков, шкалу времени, 
вспомогательные линии и общие параметры диаграммы. 

В отличие от диаграммы Ганта или сетевой диаграммы, на которых 
можно форматировать как отдельный отрезок, так и их группы (стили 
отрезков), на календаре можно форматировать только стили отрезков, а 
изменить параметры отображения одного отрезка для конкретной задачи 
нельзя. 

6.1.2. Редактирование проектных данных на календаре 

На календаре удобно редактировать план проекта, применяя те же 
приемы, что и на диаграмме Ганта. Перетаскивая отрезок целиком, можно 
изменить дату начала и окончания задачи, оставив при этом ее длительность 
без изменений. Перетаскивая только правую границу отрезка, можно 
изменять длительность задачи, а перетаскивая мышь с одной задачи на 
другую, можно создавать связи между ними. Двойным щелчком на отрезке 
открывается диалоговое окно редактирования всех свойств задачи. 
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Для создания новой задачи нужно щелкнуть в любом свободном месте 
календаря и растянуть появившийся отрезок до нужного размера. Чтобы 
удалить отрезок, нужно выделить его и нажать клавишу Delete. 

В MS Project имеется две команды, делающие работу с проектными 
данными в представлении календаря более удобной. Эти команды 
вызываются из контекстного меню любого дня. Команда Task list (Список 
задач) отображает окно с информацией обо всех задачах, выполняемых в 
выбранный день (рис. 6.2). В окне со списком задач двойной щелчок на 
названии любой из них откроет диалоговое окно редактирования всех ее 
свойств. 

 

 
 

Рис. 6.2. Список задач, работы над которыми выполняются 30 января 
2002 года в соответствии с планом проекта.  
Флажками помечены выполненные работы 

 
Поскольку на одном экране отображаются только четыре недели 

календаря, переход к задаче или дате, расположенной на несколько месяцев 
позже, может занять длительное время. Для быстрого перехода к нужной 
дате или задаче предназначена команда Go To (Перейти), вызываемая также 
из контекстного меню любого дня календаря. 

Диалоговое окно быстрого перехода к задаче или дате календаря 
(рис. 6.3) состоит из поля 10 (Ид.) и списка Date (Дата). После нажатия 
кнопки ОК календарь перестраивается таким образом, что на экране 
становится видна задача с указанным номером или выбранная дата. 
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Рис. 6.3. Диалоговое окно быстрого перехода к задаче или дате 
календаря 

6.2. График ресурсов 

На диаграмме Resource Graph (График ресурсов) отображается 
информация о различных аспектах участия ресурсов в проекте: выполняемой 
ими работе, их процентной загрузке, возможности выполнять задачи помимо 
тех, на которые они уже выделены, и стоимости. Удобство этой диаграммы 
заключается в том, что с ее помощью можно сравнивать участие в проекте 
нескольких ресурсов или ресурса и группы ресурсов (рис. 6.4), и это делает 
ее мощным аналитическим инструментом. 

 

 
 

Рис. 6.4. На ресурсном графике отображена загрузка в процентах всех 
вовлеченных в проект редакторов разделов и одного из них — Иванова 

 
Группа ресурсов отбирается на основе фильтра, и по умолчанию в 

качестве группы выступают все ресурсы проекта. Изменив условие 
фильтрации, можно изменить и состав группы. Данные можно просматривать 
как для группы в целом, так и для любого отдельного ресурса внутри группы. 
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При этом данные о группе и отдельном ресурсе можно отображать 
одновременно, как на рис. 6.4. 

Диаграмма разделена на две части. В левой части расположена 
легенда, в которой выводится название ресурса и группы, информация о 
которых отображается в правой части. Чтобы в правой части отобразилась 
информация об определенном ресурсе, его нужно выбрать в левой части. 
Выбор ресурсов осуществляется с помощью полосы прокрутки внизу левой 
части диаграммы (под легендой) или клавиш и . 

В правой части диаграммы находится сам ресурсный график. По 
горизонтали на нем расположена стандартная временная шкала, а по 
вертикали — единицы измерения, зависящие от типа отображаемой 
информации. 

6.2.1. Форматирование ресурсного графика 

Тип отображаемой на графике информации и параметры ее 
отображения определяются с помощью средств форматирования диаграммы. 
Кроме того, с помощью этих средств настраиваются вспомогательные линии 
диаграммы и временная шкала. 

6.2.1.1. Выбор типа отображаемой на графике информации 

Выбор типа отображаемой на графике информации осуществляется с 
помощью списка в подменю Format > Details (Формат > Подробности) или в 
контекстном меню диаграммы (рис. 6.5). После того как тип информации 
(табл. 6.1) выбран, график сразу перестраивается. 

 
 

Рис. 6.5. Список возможных типов отображаемых  
на ресурсном графике данных 

 
На ресурсном графике всегда можно просмотреть информацию как 

для группы ресурсов, так и для отдельного ресурса (внутри группы), причем 
MS Project определяет состав группы ресурсов на основании текущей 
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настройки фильтрации. Поскольку режимом фильтрации по умолчанию 
является отображение всех ресурсов, то по умолчанию на диаграмме 
отображается информация для группы, состоящей из всех ресурсов, 
участвующих в проекте.  

Таблица 6.1  
Описание отображаемых на ресурсном графике типов данных 

 

Тип данных Описание 

1 2 
Peak Units (Пиковые 
единицы) 

Максимальная нагрузка ресурса в процентах за 
период. Например, при периоде в неделю и загрузке в 
понедельник на 100 % (8 часов работы) и во вторник 
на 50 % (4 часа работы) пиковая нагрузка за неделю 
будет 100 %. При периоде в один день пиковая 
нагрузка за понедельник составит 100 %, а за вторник 
— 50 % 

Work 
(Трудозатраты)  

Работа ресурса в числе часов за период  

Cumulative Work 
(Совокупные 
трудозатраты)  

Накопленная к текущему моменту работа ресурса в 
количестве часов. Например, при работе в 
понедельник 4 часа, во вторник 5 и в среду 6 часов 
накопленная работа в понедельник будет 4 часа, во 
вторник 9, а в среду 15 часов  

Overallocation 
(Превышение 
доступности)  

Превышение ресурсом доступного рабочего времени 
за период. Например, при рабочем дне в 8 часов 
ресурс работает в понедельник 10 часов и во вторник 2 
часа. В таком случае перегрузка за понедельник будет 
равняться двум часам, но перегрузки за неделю не 
будет, так как из возможных 40 часов ресурс 
отрабатывает только 12  

Percent Allocation 
(Процент загрузки)  

Соотношение работы ресурса и доступного рабочего 
времени за период. Например, если ресурс работает 10 
часов в понедельник и 2 часа во вторник, то 
относительная нагрузка в понедельник будет 125 %, а 
во вторник — 25 %. При этом относительная нагрузка 
за неделю составит 30 %  

Remaining 
Availability 
(Оставшаяся 
доступность)  

Число не занятых работой часов за период. Например, 
при работе в понедельник в течение 10 часов 
доступная нагрузка за понедельник равна нулю. При 
этом за неделю доступная нагрузка будет равна 30 
часам  
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Окончание табл. 6.1 
1 2 

Cost (Затраты)  Стоимость работы ресурса за период (определяется 
путем умножения числа часов, затраченных на 
работу, на почасовую ставку)  

Cumulative Cost 
(Совокупные затраты)  

Накопленная к текущему моменту стоимость 
работы ресурса. Рассчитывается аналогично 
накопленной работе (являясь производным от нее 
параметром)  

Work Availability 
(Доступность по 
трудоемкости)  

Число часов, на которые ресурс может быть 
загружен работой за период. При стандартных 
настройках это 8 часов в день и 40 часов в неделю  

 
По умолчанию на графике отображается информация об одном 

ресурсе группы, общая же информация обо всех членах группы не 
выводится. Для того чтобы определить, каким образом должны отображаться 
данные о ресурсах, и вывести на график информацию о группе ресурсов, 
предназначено диалоговое окно форматирования диаграммы. 

6.2.1.2. Настройка параметров отображения данных на диаграмме 

Диалоговое окно форматирования ресурсного графика открывается с 
помощью команды меню Format > Bar Styles (Формат > Стили отрезков) или 
команды Bar Styles (Стили отрезков) в контекстном меню диаграммы. С 
помощью этого диалогового окна (рис. 6.6) настраивается вид графика 
только для текущего типа данных, и для определенных типов некоторые из 
параметров недоступны. 

 

 
 

Рис. 6.6. Диалоговое окно форматирования ресурсного графика 
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Внимание: Чтобы данные для группы ресурсов или отдельного 
ресурса отображались на диаграмме, нужно выбрать способ отображения 
этих данных. Если же оставить значение Don'tShow (He показывать), то 
данные на диаграмме не появятся. 

6.2.1.3. Выбор типа отображаемой на графике информации  
и ее форматирование 

Выбор типа отображаемой на графике информации осуществляется с 
помощью списка в подменю Format > Details (Формат > Подробности) или в 
контекстном меню диаграммы. Для выбора типа информации нужно 
щелкнуть на соответствующем пункте списка (названия пунктов 
соответствуют названиям полей таблицы). Таким же образом отменяется 
отображение типа данных. 

Можно выбрать сразу несколько типов данных, и в таком случае 
каждой строке таблицы с названиями задач и ресурсов будут соответствовать 
несколько строк на диаграмме. Например, на рис. 6.7 диаграмма содержит 
данные об объеме работ и их стоимости. 

Однако набор доступных типов информации не исчерпывается 
списком в подменю Format > Details (Формат > Подробности). Для выбора 
дополнительных типов служит диалоговое окно настройки отображаемых 
данных, вызываемое командой меню Format > Detail Styles (Формат > Стили 
подробных данных) или одноименной командой контекстного меню 
диаграммы. В этом же диалоговом окне (рис. 6.8) осуществляется и 
форматирование диаграммы. 

 

 
 

Рис. 6.8. С помощью списка определяется, какая информация будет 
отображена на диаграмме 
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Первая вкладка диалогового окна, Usage Details (Подробности 

использования), содержит два списка с названиями полей (полей из 
«внутренней» таблицы с информацией о задачах). В списке Available fields 
(Доступные поля) приведены поля, информацию из которых можно вывести 
на диаграмме. В списке Show these fields (Показывать эти поля) содержатся 
названия отображенных на диаграмме полей. 

Для перемещения названий полей между списками служат кнопки 
Show» (Показать») и «Hide («Скрыть). Кнопки Move (Порядок) со стрелками 
вверх и вниз, расположенные справа от списка отображаемых полей, 
используются для определения порядка отображения полей на диаграмме. 
Например, на рис. 6.9 сначала идет поле Work (Трудозатраты), а затем Cost 
(Затраты). Соответственно этим настройкам на рис. 6.8 рядом с каждой 
задачей или ресурсом выше находится строка с информацией об объеме 
работ, и ниже — с данными о стоимости этих работ. 

 

 
 

Рис.6.9. На первой вкладке диалогового окна определяется, какие 
данные отображаются на диаграмме 

 
Выделив название любого из полей и установив значения параметров 

Font (Шрифт), Cell background (Фон ячейки) и Pattern (Узор), можно 
определить, каким шрифтом будут отображаться данные из этого поля на 
диаграмме и какого цвета будут ячейки с этими данными. Например, на 
рис. 6.8 видно, что данные о стоимости отображаются на более темном фоне, 
чем другие. Это произошло из-за того, что в диалоговом окне для этого поля 
был определен более темный фон ячеек. 

Для быстрого вызова необходимых полей удобно использовать 
флажок Show in menu (Показывать в меню). Названия полей, при настройке 
которых этот флажок был установлен, всегда отображаются в списке Format 
> Details (Формат > Подробности).  
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Примечание: Таким образом, в левом списке вкладки показаны поля, 
уже отображаемые на диаграмме. В правом списке показаны те поля, 
которые могут появиться на диаграмме, причем их можно отобразить в 
контекстном меню диаграммы или в подменю Format > Details (Формат > 
Подробности), установив флажок Show in menu (Показывать в меню). 

Помимо полей, существующих во «внутренней» таблице, в списках 
фигурируют названия All Task Rows (Все строки задач) и All Assignment 
Rows (Все строки назначений). Эти псевдополя предназначены для быстрого 
форматирования всех данных, отображающихся на диаграмме в строках, 
относящихся к задачам или к назначенным на задачи ресурсам. 

Параметры форматирования псевдополя применяются, если оно 
помещено в список для отображения. Например, на рис. 6.9 в этом списке 
числится All Assignment Rows (Все строки назначений), и поэтому настройки 
форматирования этого псев-дололя (белый фон) применены ко всем данным, 
относящимся к назначенным ресурсам (см. рис. 6.8). Именно поэтому 
данные, относящиеся к задачам, имеют желтый и синий фон, а данные, 
относящиеся к ресурсам, — белый. 

На второй вкладке диалогового окна, Usage Properties (Свойства 
использования) (см. рис. 6.8, 6.4), настраиваются общие параметры 
отображения данных. В списке Align details data (Выравнивание подробных 
данных) определяется ориентация данных внутри ячеек: Right (по правому 
краю), Left (По левому краю) или Center (По центру). Параметр Display 
details header column (Показывать столбец с заголовками подробных данных) 
определяет, будет ли отображаться столбец с названиями полей, данные из 
которых выводятся на диаграмме (на рис.6.8 это первый столбец на 
диаграмме). Если используется оформление разных рядов данных разными 
цветами, то колонку можно убрать, установив значение No (Нет) для этого 
параметра. При выборе варианта Automatic (Авто) заголовки будут исчезать, 
если выводится информация только из одного поля (в таком случае заголовок 
не нужен), и появляться при добавлении второго поля. 

 

 
 

Рис. 6.10. Вкладка настройки общих свойств диаграммы 
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Флажок Repeat details header on all assignment rows (Повтор заголовков 

подробных данных для всех строк назначений) определяет, будут ли в 
строках с данными для ресурсов отображаться заголовки. На рис. 6.8, 
например, этот режим включен, и названия полей, из которых выводятся 
данные, отображаются на диаграмме в строках, соответствующих данным о 
ресурсах. 

Некоторые поля имеют длинные названия, и при включенном 
отображении заголовков данных колонка с заголовками может из-за этого 
увеличиться. Чтобы она не отнимала место у данных, можно использовать в 
ней сокращенные названия полей, для чего нужно установить флажок Display 
short detail header names (Сокращенные заголовки подробных данных). 

На рис. 6.11 представлена диаграмма, при форматировании которой 
было отключено повторение заголовков для назначений (и в результате в 
строках с данными для ресурсов не отображаются названия полей). Кроме 
того, из списка отображаемых полей было удалено псевдополе All 
Assignment Rows (Все строки назначений), в результате чего относящиеся к 
ресурсам строки отформатированы так же, как и строки, относящиеся к 
задачам (в отличие от диаграммы на рис. 6.8, где это псевдополе 
использовалось). 

 

 
 

Рис. 6.11. Диаграмма использования задач после форматирования 
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Лабораторная работа № 7  

ПРЕДСТАВЛЕНИЯ И ФОРМЫ 

Задание для выполнения работы 

1. Создайте одиночное представление, взяв за основу диаграмму 
Ганта и созданные ранее таблицу, фильтр и группу. Добавьте новое 
представление в меню и откройте его.  

2. Создайте новое комбинированное представление, в котором 
будут сочетаться диаграмма Ганта и форма сведений о задаче.  

3. Создайте новый файл и переместите в него представления.  
 

Контрольные вопросы 

1. Что такое одиночные и комбинированные представления.  
2. Как просматривать информацию с помощью одиночных и 

комбинированных представлений.  
3. Как создавать и настраивать представления.  
4. Как использовать существующие представления при создании 

новых.  
5. Что такое формы и как их использовать.  
6. Как использовать формы в комбинированных представлениях.  
7. Как перемещать представления и их элементы между 

проектными файлами.  

7.1. Просмотр информации с помощью представлений 

При создании файла проекта для просмотра данных открывается 
представление по умолчанию, а при открытии файла — представление, в 
котором просматривали проектную информацию перед закрытием файла. 

Переключаться между представлениями можно с помощью панели 
представлений (View Bar) или меню View (Вид). На панели представлений и 
в меню перечислены только те представления, в настройках которых 
установлен соответствующий флажок, а полный список представлений 
вызывается с помощью команды меню View > More Views (Вид > Другие 
представления) (рис. 7.1). 
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Рис. 7.1. Диалоговое окно со списком всех представлений 
 

При загрузке этого диалогового окна курсором выделено открытое в 
данный момент представление. Чтобы открыть другое представление, нужно 
установить на него курсор и нажать кнопку Apply (Применить). 

По умолчанию список состоит только из одиночных представлений 
(Single view), то есть содержащих одну диаграмму или таблицу. Но часто 
бывает удобно просматривать информацию о ресурсах или задачах на двух 
диаграммах одновременно (то есть в комбинированном представлении 
(Combination view)). Например, на рис. 7.2 открыты одновременно и 
диаграмма Ганта для анализа плана проекта, и диаграмма использования 
задач для анализа участия ресурсов в выполнении выбранной задачи (файл 
1.mpp). 

Комбинированное представление создается с помощью команды 
меню Window > Split (Окно > Разделить), разделяющей окно с текущим 
видом на два окна. После этого, установив курсор в нужную часть окна, 
можно выбрать соответствующие представления с помощью панели 
представлений. Для возвращения к одиночному виду нужно воспользоваться 
командой меню Window > Remove Split (Окно > Снять разделение). 

Одиночное представление, открытое в нижней части 
комбинированного, связано с представлением, открытым в верхней части. 
Так, если оба представления содержат временную шкалу, то она 
синхронизируется, и прокрутка вдоль временной шкалы одной части окна 
приводит к автоматической прокрутке другой. Например, на рис. 7.2 
благодаря этой особенности комбинированных представлений данные о 
работе ресурсов отображаются на диаграмме использования задач точно под 
отрезком, обозначающим эту задачу на диаграмме Ганга. 
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Рис. 7.2. Комбинированное представление сочетает два одиночных: 
диаграмму Ганта и диаграмму использования задач 

 
Данные, отображаемые в нижнем представлении, также связаны с 

данными верхнего представления. Например, на рис. 7.2 в нижнем 
представлении отображается информация только о задаче, выбранной в 
верхнем представлении, а не все данные, которые обычно отображаются на 
диаграмме использования задач. И если выделить две задачи на диаграмме 
Ганта, то в нижнем представлении появится информация о двух задачах, а не 
об одной. 

Благодаря такой связи составляющих комбинированного 
преставления с его помощью можно просматривать данные в разнообразных 
срезах. Например, на рис. 7.3 в комбинированном представлении диаграмма 
Ганта совмещена с ресурсным графиком. На ресурсном графике можно 
просматривать информацию о работе любого из ресурсов, задействованных в 
выделенных на диаграмме Ганта задачах, причем работа над выделенными 
задачами отображается особым цветом. 
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Рис. 7.3. Комбинированное представление с диаграммой Ганта и 
ресурсным графиком 

 
На рис. 7.3 светлые столбцы обозначают работу ресурса над 

выделенной задачей, а темные — работу над всеми остальными. При этом 
столбцы ресурсного графика распложены под соответствующими отрезками 
диаграммы Ганта. 

Для того чтобы сохранить удачно подобранные настройки, стоит 
создать новое представление и сконфигурировать его в соответствии с ними. 
Это гарантирует, что настройки можно будет использовать в дальнейшем при 
просмотре информации как из текущего проекта, так и из других. 

7.1.1. Создание нового представления 

Чтобы создать новое представление, в диалоговом окне со списком 
представлений (рис. 7.1) нужно щелкнуть на кнопке New (Создать). В 
открывшемся окне (рис. 7.4) определяется тип создаваемого представления: 
Single view (Одиночное представление) или Combination view 
(Комбинированное представление). 

 

 
 

Рис. 7.4. Определение типа создаваемого представления 
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После задания типа нового представления открывается диалоговое 
окно определения его свойств. В зависимости от того, какое представление 
создается, будет открыто диалоговое окно определения свойств или 
одиночного, или комбинированного представления. 

В диалоговом окне определения свойств одиночного представления 
(рис. 7.5) поле Name (Имя) задает название нового представления. Это 
название отображается в списке всех представлений и в меню. Для того 
чтобы название представления отображалось в меню, нужно установить 
флажок Show in menu (Показывать в меню). 

 

 
 

Рис. 7.5. Диалоговое окно определения свойств одиночного 
представления 

 
Параметр Screen (Экран) определяет, какая диаграмма или форма 

ляжет п основу представления. При этом список возможных вариантов 
ограничивается рассмотренными диаграммами (формы, которые можно 
использовать для создания представлений, мы рассмотрим в этом уроке 
позже). 

От значения параметра Screen (Экран) зависит, какие параметры 
можно будет настроить для создаваемого представления. Параметр Table 
(Таблица) можно использовать только в случае, если выбранный экран 
содержит таблицу. В этом списке можно выбрать таблицу, которая будет 
отображаться при загрузке представления. 

Параметр Group (Группа) также можно определить только в случае, 
если на диаграмме возможна группировка данных. Тогда можно выбрать из 
списка группу, которая будет использоваться при группировке. 

Условия фильтрации данных можно определить для любой 
диаграммы с помощью параметра Filter (Фильтр), определяющего, какой из 
существующих фильтров будет применен для отбора отображаемых в 
представлении данных. Для того чтобы использовать фильтрацию в режиме 



 89

подсветки, предназначен флажок Highlight filter (Выделять результаты 
фильтра). 

Диалоговое окно определения свойств комбинированного 
представления (рис. 7.6) устроено проще аналогичного окна для одиночного 
представления. В поле Name (Имя) следует ввести название нового 
представления, а для того, чтобы оно отображалось в меню и на панели 
представлений, нужно установить флажок Show in menu (Показывать в 
меню). 

 

 
 

Рис. 7.6. Диалоговое окно определения свойств комбинированного 
представления 

 
В раскрывающихся списках Тор (Вверху) и Bottom (Внизу) 

определяются представления, которые будут отображаться в верхней и 
нижней части нового представления. При этом список доступных 
представлений состоит не только из стандартных диаграмм (как в 
диалоговом окне создания одиночного представления), а из всего набора 
существующих одиночных представлений, в том числе и настроенных 
пользователем. 

После того как создание представления завершено, оно появляется в 
списке доступных представлений и его можно вызывать либо из списка, либо 
(если установлены соответствующие настройки) из меню или панели 
представлений.  

7.2. Формы 

Форма — это средство отображения и редактирования проектных 
данных в MS Project, которое может быть включено в состав представления. 
С помощью форм можно просматривать информацию только об одном 
объекте (ресурсе или задаче), но при этом можно редактировать почти все 
его свойства (рис. 7.7). 

Формы вызываются с помощью окна списка представлений, в котором 
представлены все доступные формы. Отличить их можно по названию — оно 
всегда содержит слово Form (Форма), например форма на рис. 7.7 называется 
Resource Form (Форма ресурсов). 
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Рис. 7.7. Форма редактирования свойств ресурса 
 
Из-за удобства редактирования и неудобства просмотра общей 

проектной информации формы обычно используются в нижней части 
комбинированного представления. В таком случае в верхнем представлении 
можно анализировать план проекта и выбирать нужную задачу, а в нижней 
части представления редактировать ее свойства в форме (рис. 7.8). 

Удобство использования форм в комбинированном представлении 
подтверждает и тот факт, что при разбиении окна командой меню Window > 
Split (Окно > Разделить) именно форма загружается в нижнюю часть 
представления. 
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Рис. 7.8. В комбинированном представлении сочетаются диаграмма 
Ганта и форма редактирования свойств задачи 

7.2.1. Настройка отображаемой на форме информации 

В MS Project входят пять форм. С помощью первых двух можно 
просматривать и редактировать информацию о ресурсах, а трех 
последующих — о задачах: 

• Resource Form (Форма ресурсов)  
• Resource Name Form (Форма названий ресурсов)  
• Task Form (Форма задач)  
• Task Name Form (Форма названий задач) Task Details Form 

(Форма сведений о задачах)  
Все формы имеют одинаковую структуру: в верхней части 

располагается заголовок, а под ним отображается информационный блок. 
Заголовок содержит поля для редактирования свойств задачи или ресурса. 
Число полей зависит от типа формы, например, на рис. 7.9 в заголовке формы 
названий ресурсов присутствует только поле Name (Название). 

Рядом с этими полями располагаются кнопки Previous 
(Предыдущий/Предыдущая) (В зависимости от того, к задаче или к ресурсу 
относится форма) и Next (Следующий/Следующая), которые служат для 
перемещения по списку задач или ресурсов. Если данные в форме были 
отредактированы, эти кнопки меняют названия на ОК и Cancel (Отмена) для 
принятия или отмены сделанных изменений. 
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Рис. 7.9. В комбинированном представлении соединены форма 
названий ресурсов (Resource Name Form) и форма ресурсов (Resource Form). 
В заголовке формы названий можно редактировать лишь название ресурса 

 
В информационном блоке отображается дополнительная информация 

о ресурсе или задаче, например список задействованных ресурсов, стоимость 
работ каждого из них, связанные объекты, заметки и пр. Например, 
представленная на рис. 7.8 форма содержит список задействованных в задаче 
ресурсов и список предшествующих задач. 

Для выбора типа отображаемой информации можно воспользоваться 
контекстным меню формы или подменю Format > Details (Формат > 
Подробности). Состав меню для форм с информацией о ресурсах и форм с 
информацией о задачах различается, но в обоих случаях в меню есть 
команды Notes (Заметки) и Objects (Объекты) для просмотра и 
редактирования связанных с задачей или ресурсом объектов (например, 
файлов) и заметок. Именно информация о заметках просматривается в форме 
описания ресурса в верхней части комбинированного представления на 
рис. 7.9. 

На ресурсной форме можно просматривать и редактировать данные о 
календарном плане (Shedule), затратах (Cost) и трудозатратах (Work) ресурса. 
При выборе любой из этих команд в информационном блоке отобразится 
таблица со списком задач, задействующих этот ресурс, и данные, 
соответствующие выбранной команде меню: даты участия в задаче и ее 
длительность, стоимость участия ресурса в работах или объем работы, 
который ресурс должен выполнить в рамках выполнения задач. Например, в 
форме названий ресурсов на рис. 7.9 в нижней части комбинированного 
представления просматриваются данные о календарном плане ресурса. 
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Используя команды подменю Format > Details (Формат > 
Подробности), для формы с информацией о задаче можно просматривать и 
редактировать информацию как о задействованных в задаче ресурсах, так и о 
связях задачи с другими задачами проекта. 

При выборе команды Resources & Predecessors (Ресурсы и 
предшественники) (см. рис. 7.8) будут отображены две таблицы, в одной из 
которых содержится информация о задействованных в задаче ресурсах, а в 
другой перечислены задачи - предшественники выбранной. Команда 
Resources & Successors (Ресурсы и последователи) действует аналогично, 
отображая во второй таблице информацию не о предшествующих, а о 
последующих задачах. А команда Predecessors & Succesors 
(Предшественники и последователи) совместит таблицы с данными о 
предшествующих и последующих задачах в информационном блоке формы. 
На рис. 7.10 в форме описания задачи в верхней части комбинированного 
представления отображаются данные о ресурсах и предшествующих задачах. 

 

 
 

Рис. 7.10. Комбинированное представление, сочетающее форму 
задачи (Task Form) и форму сведений о задачах (Task Details Form). Форма 
сведений о задачах содержит больше полей в заголовке, чем форма задач 

 
На форме описания задачи можно также просматривать данные об 

участии ресурсов в выбранной задаче, основываясь на календарном плане 
ресурсов (Resource Shedule), затратах на ресурсы (Resource Cost) и 
трудозатратах ресурса (Resource Work). При выборе любой из этих команд в 
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информационном блоке отобразится таблица со списком участвующих в 
задаче ресурсов, а также данные, соответствующие выбранной команде 
меню. Например, в нижнем блоке комбинированного представления на 
рис. 7.10 в расширенной форме отображается таблица с данными о стоимости 
участия ресурсов. 

Совет: Если диаграммы предназначены в первую очередь для 
просмотра данных, то формы — для их ввода и редактирования. Поэтому 
формы и диаграммы очень удобно применять вместе. Если подвести мышь к 
нижней стрелке правой полосы прокрутки и потащить полоску, 
расположенную под ней, то на экране появится форма, сочетающаяся с 
открытой диаграммой. 

7.3. Удаление и перемещение представлений и их составляющих 

Рассматривая представления и их составляющие, мы ни разу не 
остановились на том, как осуществляется их удаление. Дело в том, что для 
этого предназначен специальный Организатор, который можно вызвать 
одноименной кнопкой из диалогового окна со списком представлений, 
таблиц, фильтров и групп или с помощью команды меню Tools > Organizer 
(Сервис > Организатор) (рис.7.11). 

 

 
 

Рис. 7.11. Диалоговое окно Организатора 
 

Диалоговое окно Организатора состоит из вкладок, соответствующих 
типам объектов в MS Project например, на рис. 7.11 активна вкладка Views 
(Представления). На вкладке осуществляются операции над объектами 
определенного типа в соответствии с ее названием. Например, на вкладке 
Views (Представления) вы можете копировать, удалять и переименовывать 
представления, а на вкладке Forms (Формы) — осуществлять аналогичные 
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действия с формами. Все вкладки имеют одинаковую структуру, поэтому «на 
примере одной из них можно понять, как работают все остальные. 
Рассмотрим работу с представлениями и их составляющими на примере 
вкладки Views (Представления). 

Вкладка состоит из двух списков, в которых отображаются названия 
объектов соответствующего типа, размещенные в файлах, открытых в 
данный момент в MS Project. Имя файла можно выбрать в раскрывающемся 
списке, расположенном под списком файлов. 

ПРИМЕЧАНИЕ: В начале работы MS Project всегда загружает 
глобальный шаблон, на основе которого создаются новые проекты, — 
Global.MPT. Если в MS Project открыт только один файл, то с помощью 
Организатора можно обмениваться объектами с глобальным шаблоном 
(рис. 7.11). 

С помощью находящейся между списками кнопки Сору (Копировать) 
можно копировать элементы из одного списка в другой. Кнопка Rename 
(Переименовать) позволяет изменить название элемента (кроме некоторых 
стандартных, например нельзя переименовать диаграмму Ганта). Кнопка 
Delete (Удалить) удаляет объект, а кнопка Close (Закрыть) закрывает 
диалоговое окно. 

Если в процессе работы было создано удобное представление 
(таблица и т. д.), то для того, чтобы воспользоваться им в дальнейшем, его 
нужно скопировать в файл Global.MPT. После этого оно будет доступно во 
вновь создаваемых проектах. Чтобы перенести представление или другой 
элемент интерфейса MS Project в существующий файл, нужно открыть его 
одновременно с тем файлом, где хранится копируемый объект, и 
скопировать. 
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Лабораторная работа № 8  

СОЗДАНИЕ ИНДИВИДУАЛЬНОГО ПРОЕКТА 

Задания для выполнения работы 

Исходные данные 
Вариант 1 2 3 4 5 6 7 8 9 10 

Производственная 
мощность 
оборудования (шт.) 

4 934 5 730 5 474 5 908 5 744 5 677 5 594 6 005 5 922 5 856 

Стоимость зданий 
(руб.) 78185,07 88785,5 87290,55 85961,12 88898,83 86322,87 85345,09 87859,1 84564,7 86061,83 

Стоимость 
оборудования (руб.) 39684,78 84828,46 88959,23 88582,19 84477,05 112613,4 102761,8 112476,2 120306,6 93958,25 

ЗП директора в месяц 
(руб.) 276,0908 352,9934 373,741 293,3944 351,8405 374,7979 358,6443 358,1606 339,3108 327,4682 

ЗП бухгалтера в месяц 
(руб.) 177,0876 229,2836 284,9906 248,7784 225,0231 214,7064 273,3861 246,8138 239,8448 271,8092 

ЗП начальника цеха в 
месяц (руб.) 157,0024 186,705 202,0622 207,1649 181,0482 197,6792 181,6134 186,3425 215,8041 189,6731 

Основные рабочие  
Рабочий 4 раз (чел.) 2,212435 3,988117 5,937343 3,657167 7,403576 3,995365 5,467908 5,372618 6,161823 3,824244 
Рабочий 3 раз (чел.) 4,627219 2,619161 4,981984 5,138483 5,722305 5,312258 3,412368 5,9582 4,984661 4,747458 
Рабочий 2 раз (чел.) 5,873936 6,566673 5,634284 6,33384 5,850637 3,910118 6,044457 5,650646 6,254327 5,523971 

Вспомогательные рабочие  
Разнорабочий  
1 разряда (чел.) 1 0,988117 2,937343 0,657167 4,403576 0,995365 2,467908 2,372618 3,161823 0,824244 
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Сторож (чел.) 1 1 1 1 1 1 1 1 1 1 
ЗП работника  
1 разряда (руб.) 72,12435 89,88117 109,3734 86,57167 124,0358 89,95365 104,6791 103,7262 111,6182 88,24244 

Металлоотходы (кг) 20 11,67027 19,87845 19,01152 22,79286 18,48389 18,2281 22,26672 20,42217 19,09306 
Полистирол (кг) 500 439,2266 519,4644 530,3411 503,2319 506,8043 494,2667 524,7861 498,1575 526,4224 
Песок (кг) 0,1 0,044957 0,078379 0,098053 0,089092 0,130475 0,100855 0,136245 0,093747 0,094362 
Полиэтилен (кг) 0,01 -0,05033 0,008227 -0,04479 -0,03236 -0,00477 0,017704 -0,02421 -0,00231 0,037327 
Паста 
противопригарная (кг) 0,001 -0,00501 0,002819 0,001285 0,002564 0,001364 0,002531 -0,00123 -0,00086 0,000424 

Стекло (кг) 0,01 0,004016 0,007457 0,007139 0,009977 0,012591 0,012547 0,008516 0,007293 0,012828 
Электроэнергия 
(Квт\час) 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 

Вода и канализация 
(м3) 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 

Сбытовые издержки 
(руб.) 

1200 1159,339 1198,188 1205,454 1188,926 1187,121 1240,31 1194,015 1169,172 1196,377 

Здания и сооружения 
(руб.) 150000 142189,2 152231,7 147430,7 155221 150073,1 146547,8 149563 154280,2 153849,7 

Оборудование (руб.) 56000 53617,93 56640,83 56824,45 55141,27 55897,98 55945,75 56532,35 56373,88 55820,45 
Цена реализации 5 
(руб.) 66,34244 75,69949 82,63523 94,04897 90,15324 86,69326 91,40434 86,2933 95,03094 92,83116 

Цена реализации 6 
(руб.) 70,34244 79,69949 86,63523 98,04897 94,15324 90,69326 95,40434 90,2933 99,03094 96,83116 

Цена реализации 7 
(руб.) 72,34244 81,69949 88,63523 100,049 96,15324 92,69326 97,40434 92,2933 101,0309 98,83116 
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Вариант 11 12 13 14 15 16 17 18 19 20 
Производственная 
мощность 
оборудования (шт.) 5 455 5 959 5 829 5 698 5 562 5 147 5 357 5 603 5 428 5 447 
Стоимость зданий 
(руб.) 83294,81 88400,51 84964,65 80462,76 90903,82 85967,68 89047,59 89328,82 83609,34 88683,26 
Стоимость 
оборудования (руб.) 80720,97 122993,7 69103,82 101896,2 109065,7 70909,8 113148,8 100127,6 87438,83 105978,8 
ЗП директора в месяц 
(руб.) 325,1958 377,3442 365,8828 302,372 339,3988 356,4855 352,9318 309,1982 337,9512 338,2831 
ЗП бухгалтера в месяц 
(руб.) 224,2553 277,6524 216,2683 205,7311 262,4152 260,3507 227,4481 226,7232 245,3791 267,2988 
ЗП начальника цеха в 
месяц (руб.) 183,6601 216,8736 182,0318 202,0054 208,8336 189,7848 205,3281 216,3961 203,5788 220,044 

Основные рабочие  
Рабочий 4 раз (чел.) 3,778428 6,163778 4,042768 5,209327 5,791063 4,804805 5,123823 4,282552 6,472094 4,216758 
Рабочий 3 раз (чел.) 6,440294 4,562856 5,088586 3,50841 4,471813 5,934733 6,981934 5,449127 5,269004 5,869798 
Рабочий 2 раз (чел.) 5,803361 5,341471 4,735039 5,940433 3,556896 3,89644 5,702487 4,523884 4,523884 6,283065 

Вспомогательные рабочие  
Разнорабочий  
1 разряда (чел.) 0,778428 3,163778 1,042768 2,209327 2,791063 1,804805 2,123823 1,282552 3,472094 1,216758 
Сторож (чел.) 1 1 1 1 1 1 1 1 1 1 
ЗП работника  
1 разряда (руб.) 87,78428 111,6378 90,42768 102,0933 107,9106 98,04805 101,2382 92,82552 114,7209 92,16758 
Металлоотходы (кг) 24,47826 16,26258 23,51129 23,04409 15,93733 19,71972 24,9862 18,98604 22,51259 26,54083 
Полистирол (кг) 514,4685 472,0426 525,8969 501,1306 505,1641 476,2348 498,9435 480,3682 492,1819 461,7952 
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Песок (кг) 0,102867 0,074068 0,123678 0,082888 0,074111 0,118101 0,053435 0,047784 0,128575 0,074036 
Полиэтилен (кг) 0,002662 -0,01911 0,036195 0,034965 0,015728 0,009698 0,012159 0,030388 0,009213 -0,01252 
Паста 
противопригарная (кг) -0,001 -0,00197 0,003635 0,001262 -0,00173 -0,00108 -0,00228 0,001797 -0,00266 -0,00078 
Стекло (кг) 0,015545 0,006965 0,01265 0,008323 0,01063 0,012271 0,010542 0,009778 0,010616 0,008616 
Электроэнергия 
(Квт/час) 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 
Вода и канализация 
(м3) 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 
Сбытовые издержки 
(руб.) 1212,977 1178,855 1218,174 1219,108 1182,191 1200,989 1182,849 1191,177 1185,842 1193,008 
Здания и сооружения 
(руб.) 150874,4 145834,2 153523,2 150541,1 150902,3 147603,1 151157,6 146238,7 151814,8 149089,8 
Оборудование (руб.) 54583,73 54624,2 57104,99 56228,32 55026,81 55357,05 55378,96 56116,23 55824,21 56098,59 
Цена реализации 5 
(руб.) 73,92229 93,73227 80,85217 87,5533 94,49701 90,21876 82,6828 100,0284 86,77222 91,72776 
Цена реализации 6 
(руб.) 77,92229 97,73227 84,85217 91,5533 98,49701 94,21876 86,6828 104,0284 90,77222 95,72776 
Цена реализации 7 
(руб.) 79,92229 99,73227 86,85217 93,5533 100,497 96,21876 88,6828 106,0284 92,77222 97,72776 
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Вариант 21 22 23 24 25 26 27 28 29 30 
Производственная 
мощность 
оборудования (шт.) 6 259 5 656 5 395 5 040 5 098 5 612 5 710 5 735 5 754 5 758 
Стоимость зданий 
(руб.) 84635,09 89180,19 86178,77 83744,09 85404,03 87116,15 83414,67 82064,33 89000,22 83832,3 
Стоимость 
оборудования (руб.) 110583,5 94993,05 63673,1 97220,06 126997 67510,54 120440,9 104660,7 84272,53 122064,4 
ЗП директора в месяц 
(руб.) 304,2522 377,3512 349,6089 359,4242 340,0874 343,0386 348,9048 314,7994 351,0435 348,3359 
ЗП бухгалтера в месяц 
(руб.) 265,3505 271,7561 244,3222 214,0143 232,1133 212,2083 269,5681 215,7184 221,4299 264,3986 
ЗП начальника цеха в 
месяц (руб.) 211,3565 188,6786 211,8299 208,6202 202,8029 178,6956 209,373 203,5517 173,9875 203,1821 

Основные рабочие  
Рабочий 4 раз (чел.) 6,106519 3,443936 5,085668 2,055493 4,319182 3,733656 5,346909 5,280284 6,132139 4,52277 
Рабочий 3 раз (чел.) 4,968363 4,294279 4,042284 5,34285 5,104957 4,282059 4,805118 7,155421 5,36852 2,774721 
Рабочий 2 раз (чел.) 3,593826 4,212384 6,272338 5,649513 5,123823 5,169991 4,556535 5,492114 6,304797 4,13766 

Вспомогательные рабочие  
Разнорабочий  
1 разряда (чел.) 3,106519 0,443936 2,085668 1 1,319182 0,733656 2,346909 2,280284 3,132139 1,52277 
Сторож (чел.) 1 1 1 1 1 1 1 1 1 1 
ЗП работника  
1 разряда (руб.) 111,0652 84,43936 100,8567 70,55493 93,19182 87,33656 103,4691 102,8028 111,3214 95,2277 
Металлоотходы (кг) 24,53428 17,62336 20,24319 27,27414 17,63966 21,51872 19,54837 18,30431 16,36989 17,20962 
Полистирол (кг) 508,6303 503,4601 442,9115 497,2657 496,1064 476,1623 516,8158 533,5282 506,4872 498,9587 
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Песок (кг) 0,093389 0,126925 0,098856 0,126666 0,107375 0,104291 0,076008 0,104373 0,076375 0,115859 
Полиэтилен (кг) -0,01972 -0,00421 0,046111 0,002523 0,033564 -0,03119 0,007383 -0,00577 0,01681 -0,01936 
Паста 
противопригарная (кг) 0,002902 0,001601 0,000567 0,003058 -0,00221 0,000869 0,002775 0,003665 -0,00154 0,00042 
Стекло (кг) 0,010134 0,013753 0,012752 0,00874 0,008757 0,01312 0,007497 0,010206 0,010714 0,01116 
Электроэнергия 
(Квт/час) 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 
Вода и канализация 
(м3) 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 
Сбытовые издержки 
(руб.) 1189,508 1192,322 1194,901 1209,726 1200,004 1194,924 1198,686 1186,702 1183,098 1162,248 
Здания и сооружения 
(руб.) 155064 151135,3 152867,6 147565,2 151635,4 152572,2 152460,1 152851 150980,4 148573,8 
Оборудование (руб.) 54924,97 56461,78 55417,66 56167,39 55672,01 55077 56798,95 56714,85 55041,9 55329,23 
Цена реализации 5 
(руб.) 73,22249 89,27167 72,1039 86,24267 86,69712 77,82054 83,92725 87,58308 85,54004 90,44928 
Цена реализации 6 
(руб.) 77,22249 93,27167 76,1039 90,24267 90,69712 81,82054 87,92725 91,58308 89,54004 94,44928 
Цена реализации 7 
(руб.) 79,22249 95,27167 78,1039 92,24267 92,69712 83,82054 89,92725 93,58308 91,54004 96,44928 
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Вариант 31 32 33 34 35 36 37 38 39 40 
Производственная 
мощность 
оборудования (шт) 5 448 5 795 5 659 5 595 5 295 5 758 5 886 5 903 5 702 5 560 
Стоимость зданий 
(руб.) 84060,9 84433,77 88584,28 82948,67 86312,78 86114,64 88245,37 83755,73 86721,08 86179,55 
Стоимость 
оборудования (руб.) 92755,74 135062,9 89999,41 129767,3 78462,63 102070,7 128034,1 107910,4 117902,3 122202,6 
ЗП директора в месяц 
(руб.) 346,2887 356,2169 365,0354 363,5999 361,7126 349,1497 397,5927 310,0714 388,6848 321,6493 
ЗП бухгалтера в месяц 
(руб.) 257,9109 280,4347 254,8253 235,1726 267,8546 244,0275 217,5273 280,6891 230,5745 261,6486 
ЗП начальника цеха в 
месяц (руб.) 219,129 213,9254 215,6728 205,0261 195,6404 191,4501 191,4879 183,9763 205,289 200,2186 

Основные рабочие  
Рабочий 4 раз (чел.) 4,87024 5,506238 4,75385 4,588888 5,337581 3,26995 5,416946 5,379514 4,940411 4,000295 
Рабочий 3 раз (чел.) 4,23554 3,496914 4,609777 6,128806 4,389115 4,89858 4,622294 6,326612 4,141648 2,604609 
Рабочий 2 раз (чел.) 5,124439 4,16475 4,75385 6,227727 6,808698 4,181119 4,637776 6,657818 4,955272 3,677617 

Вспомогательные рабочие  
Разнорабочий  
1 разряда (чел.) 1,87024 2,506238 1,75385 1,588888 2,337581 0,26995 2,416946 2,379514 1,940411 1,000295 
Сторож (чел.) 1 1 1 1 1 1 1 1 1 1 
ЗП работника  
1 разряда (руб.) 98,7024 105,0624 97,5385 95,88888 103,3758 82,6995 104,1695 103,7951 99,40411 90,00295 
Металлоотходы (кг) 24,63232 20,30103 18,75191 22,83813 16,55478 17,17549 11,03573 21,7875 15,46572 20,88486 
Полистирол (кг) 503,3664 507,3912 547,0317 485,3724 529,5381 512,4528 538,7802 517,521 499,0547 515,2379 
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Песок (кг) 0,081912 0,111844 0,106572 0,109254 0,110212 0,086847 0,128181 0,120716 0,125675 0,125124 
Полиэтилен (кг) 0,028913 0,029699 -0,00323 -0,01778 0,0089 0,02824 0,03587 0,039852 -0,00042 -0,02981 
Паста 
противопригарная (кг) 0,000596 0,0039 0,004074 0,001157 -0,00038 7,78E-05 0,003186 0,005324 0,002385 -0,00106 
Стекло (кг) 0,006364 0,016296 0,010354 0,013699 0,006377 0,01257 0,011846 0,006097 0,007747 0,008938 
Электроэнергия 
(Квт/час)) 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 
Вода и канализация 
(м3) 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 
Сбытовые издержки 
(руб.) 1206,653 1179,838 1187,848 1195,369 1214,594 1196,96 1210,543 1180,843 1202,663 1198,282 
Здания и сооружения 
(руб.) 148429,1 147365,1 153046,4 152473,8 150880 155088,8 151672,1 147166,5 156523,1 150688,8 
Оборудование (руб.) 55112,96 55901 56715,79 54743,98 57735,38 56189,09 56219,39 55660,83 55372,16 54026,09 
Цена реализации 5 
(руб.) 85,83277 83,83939 85,07845 89,92495 76,95079 86,0002 83,4876 87,84984 77,83775 84,37668 
Цена реализации 6 
(руб.) 89,83277 87,83939 89,07845 93,92495 80,95079 90,0002 87,4876 91,84984 81,83775 88,37668 
Цена реализации 7 
(руб.) 91,83277 89,83939 91,07845 95,92495 82,95079 92,0002 89,4876 93,84984 83,83775 90,37668 
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Вариант 41 42 43 44 45 46 47 48 49 50 
Производственная 
мощность 
оборудования (шт.) 5 979 5 841 6 116 6 051 5 715 5 423 5 666 5 510 5 963 5 488 
Стоимость зданий 
(руб.) 88294,55 83947,44 81579,57 84415,7 82674,32 86699,84 86014,41 85823,4 85646,96 88878,91 
Стоимость 
оборудования (руб.) 119884,4 115183,6 78999,8 110592,3 110830,9 81177,24 108089,3 118475,8 77006,8 105207,2 
ЗП директора в месяц 
(руб.) 371,0443 335,1977 332,3177 312,1964 334,269 362,0316 365,3436 316,9359 367,2599 335,127 
ЗП бухгалтера в месяц 
(руб.) 266,8184 237,6323 245,5191 273,3624 244,6182 264,0635 283,3832 260,6389 196,9251 259,8713 
ЗП начальника цеха в 
месяц (руб.) 206,7445 216,2488 208,4193 227,0835 183,7965 190,1451 186,1152 200,8444 220,0833 208,7382 

Основные рабочие  
Рабочий 4 раз (чел.) 5,054303 6,763829 4,417996 4,305228 5,228918 4,58897 5,564334 4,286406 5,510852 6,047631 
Рабочий 3 раз (чел.) 4,857578 4,506244 4,497325 5,440091 5,186469 4,285518 5,186625 5,598302 6,094745 6,680928 
Рабочий 2 раз (чел.) 5,702976 4,846517 4,602585 4,60333 2,430787 3,64232 3,236171 6,690751 4,481638 4,351714 

Вспомогательные рабочие  
Разнорабочий  
1 разряда (чел.) 2,054303 3,763829 1,417996 1,305228 2,228918 1,58897 2,564334 1,286406 2,510852 3,047631 
Сторож (чел.) 1 1 1 1 1 1 1 1 1 1 
ЗП работника   
1 разряда (руб.) 100,543 117,6383 94,17996 93,05228 102,2892 95,8897 105,6433 92,86406 105,1085 110,4763 
Металлоотходы (кг) 19,50306 19,97235 19,83319 19,04321 20,94376 17,08519 23,17044 22,55884 20,17785 18,64855 
Полистирол (кг) 512,1557 498,4006 556,0777 498,3146 440,2311 514,2021 492,632 527,2838 519,276 537,8082 



 105 

Песок (кг) 0,143507 0,09727 0,100568 0,103226 0,094055 0,090409 0,123805 0,141922 0,073836 0,104451 
Полиэтилен (кг) -0,00411 0,00558 -0,03203 0,018995 0,025751 0,037089 0,004265 -0,02225 0,003354 -0,00706 
Паста 
противопригарная (кг) 0,0012 0,000415 0,001248 0,002507 -0,00135 0,000812 0,003968 -0,00118 0,001951 0,00328 
Стекло (кг) 0,011945 0,009269 0,006608 0,01226 0,010125 0,006174 0,009587 0,008517 0,013686 0,009894 
Электроэнергия 
(Квт/час) 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 
Вода и канализация 
(м3) 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 
Сбытовые издержки 
(руб.) 1179,618 1193,995 1202,964 1223,642 1219,444 1204,43 1223,276 1193,795 1189,355 1181,744 
Здания и сооружения 
(руб.) 148983,7 148641,1 146211,7 144836,7 148335,5 147474,7 149664,3 149482,3 150180,2 151884,3 
Оборудование (руб.) 55214,61 55379,92 56332 55585,45 55824,55 57231,11 58384,47 56459,99 55733,71 56308,73 
Цена реализации 5 
(руб.) 79,54564 78,09675 83,50569 90,93603 84,85193 85,18289 90,56163 88,04881 80,63506 76,70307 
Цена реализации 6 
(руб.) 83,54564 82,09675 87,50569 94,93603 88,85193 89,18289 94,56163 92,04881 84,63506 80,70307 
Цена реализации 7 
(руб.) 85,54564 84,09675 89,50569 96,93603 90,85193 91,18289 96,56163 94,04881 86,63506 82,70307 
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Вариант 51 52 53 54 55 56 57 58 59 60 
Производственная 
мощность 
оборудования (шт.) 5 883 5 942 6 372 6 547 5 761 5 622 5 534 5 557 5 939 5 195 
Стоимость зданий 
(руб.) 84563,22 87710,38 86447,8 86242,04 85556,22 85243,95 83158,37 84895,4 86384,22 85435,65 
Стоимость 
оборудования (руб.) 124112,3 113646,8 86262,7 81500,49 92562,66 98955,33 66175,66 98315,21 94323,07 126445,7 
ЗП директора в месяц 
(руб.) 344,9602 361,8708 377,3408 367,8349 330,1108 350,2018 388,0819 352,0189 323,7728 339,0904 
ЗП бухгалтера в месяц 
(руб.) 250,8637 254,7357 218,9337 288,303 290,5503 254,8604 264,2836 262,3115 262,0466 229,2216 
ЗП начальника цеха в 
месяц (руб.) 184,7219 196,7403 228,9446 207,8556 201,8562 207,348 195,6547 221,4565 236,1159 200,3942 

Основные рабочие  
Рабочий 4 раз (чел.) 4,836757 3,669691 5,540186 4,243917 5,682651 6,337385 5,600407 4,729727 5,268528 3,852186 
Рабочий 3 раз (чел.) 5,964637 4,337491 5,798195 4,687742 5,786156 4,438446 4,625331 5,492287 5,80611 5,096653 
Рабочий 2 раз (чел.) 3,298936 4,37439 5,612545 6,051212 5,629988 4,822942 5,069786 5,213552 4,104568 3,713265 

Вспомогательные рабочие  
Разнорабочий  
1 разряда (чел.) 1,836757 0,669691 2,540186 1,243917 2,682651 3,337385 2,600407 1,729727 2,268528 0,852186 
Сторож (чел.) 1 1 1 1 1 1 1 1 1 1 
ЗП работника   
1 разряда (руб.) 98,36757 86,69691 105,4019 92,43917 106,8265 113,3738 106,0041 97,29727 102,6853 88,52186 
Металлоотходы (кг) 20,31164 26,29038 14,6767 18,65947 22,65968 20,91487 24,83215 20,88391 19,78742 19,04248 
Полистирол (кг) 483,7555 501,591 547,3506 536,0982 494,418 499,2838 546,8028 500,3206 502,7682 476,6025 
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Песок (кг) 0,12796 0,071297 0,12961 0,10361 0,144745 0,092521 0,059009 0,094715 0,106551 0,127161 
Полиэтилен (кг) 0,016014 0,016863 0,035514 -0,00902 0,014154 -0,00688 -0,02475 -0,00245 0,02196 0,020397 
Паста 
противопригарная (кг) -0,00018 -0,00111 0,003041 0,002978 -0,00117 -0,00197 -0,0019 -0,00105 0,002736 0,000728 
Стекло (кг) 0,014791 0,011257 0,011622 0,009655 0,011483 0,013751 0,007532 0,006681 0,012409 0,008299 
Электроэнергия 
(Квт/час) 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 
Вода и канализация 
(м3) 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 
Сбытовые издержки 
(руб.) 1206,767 1190,484 1208,555 1176,651 1193,706 1213,91 1185,563 1225,545 1223,52 1234,206 
Здания и сооружения 
(руб.) 148985,6 152535,3 151208,8 151367,3 154160,1 151436,2 147616,5 152943,1 144052,9 152020,4 
Оборудование (руб.) 55840,99 55888,51 56002,08 56107,44 56435,32 55512,06 55572,34 56034,8 55412,25 54647,96 
Цена реализации 5 
(руб.) 104,2649 84,07115 78,3222 80,81445 78,01529 82,35088 83,32714 81,97942 91,77893 82,40889 
Цена реализации 6 
(руб.) 108,2649 88,07115 82,3222 84,81445 82,01529 86,35088 87,32714 85,97942 95,77893 86,40889 
Цена реализации 7 
(руб.) 110,2649 90,07115 84,3222 86,81445 84,01529 88,35088 89,32714 87,97942 97,77893 88,40889 
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Вариант 61 62 63 64 65 66 67 68 69 70 
Производственная 
мощность 
оборудования (шт.) 5 611 5 359 5 805 5 293 5 096 6 039 5 541 5 539 5 746 5 815 
Стоимость зданий 
(руб.) 82114,38 87410,9 85895,06 82148,01 84770,39 86202,82 87881,77 86973,25 79230,58 86497,52 
Стоимость 
оборудования (руб.) 116372,3 96290,05 94855,97 74567,69 111730,8 86427,01 92358,63 76438,44 96656,96 103865,9 
ЗП директора в месяц 
(руб.) 348,6673 314,2338 332,6161 321,1116 309,5562 382,8635 378,8139 352,5912 374,7698 349,7925 
ЗП бухгалтера в месяц 
(руб.) 279,4589 243,5837 292,1892 226,0541 266,7777 231,5479 289,2585 242,8137 261,2197 241,5078 
ЗП начальника цеха в 
месяц (руб.) 231,9997 195,5109 200,7686 189,2516 212,2527 188,2701 201,557 205,9935 221,5302 185,8398 

Основные рабочие  
Рабочий 4 раз (чел.) 4,119545 4,613735 5,393114 4,674139 6,180656 4,12528 5,644702 4,129532 4,81532 5,784698 
Рабочий 3 раз (чел.) 5,076689 3,999917 2,586692 3,826227 5,583998 6,063388 6,268395 3,982612 5,140724 4,715656 
Рабочий 2 раз (чел.) 5,313303 5,036689 4,053837 5,090813 6,50736 4,389577 4,02471 5,786781 4,955041 5,986179 

Вспомогательные рабочие  
Разнорабочий 1 
разряда (чел.) 1,119545 1,613735 2,393114 1,674139 3,180656 1,12528 2,644702 1,129532 1,81532 2,784698 
Сторож (чел.) 1 1 1 1 1 1 1 1 1 1 
ЗП работника  
1 разряда (руб.) 91,19545 96,13735 103,9311 96,74139 111,8066 91,2528 106,447 91,29532 98,1532 107,847 
Металлоотходы (кг) 20,46324 23,68415 13,11478 20,06231 19,19989 17,77489 23,15045 18,19411 20,87576 23,03068 
Полистирол (кг) 561,0063 505,0759 509,8064 492,3304 495,4137 504,2823 500,8543 519,0546 460,8564 485,9034 
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Песок (кг) 0,096628 0,08906 0,091383 0,084495 0,09698 0,128823 0,081522 0,091748 0,098012 0,109237 
Полиэтилен (кг) 0,034666 0,064246 0,065991 -0,02175 0,007933 -0,00327 0,031886 0,035113 0,036206 -0,01884 
Паста 
противопригарная (кг) -0,00012 0,002117 0,001882 0,004246 0,000918 0,001679 0,001013 0,000479 -0,00012 0,001066 
Стекло (кг) 0,011419 0,009414 0,008952 0,011739 0,010043 0,014115 0,007854 0,013412 0,01134 0,013232 
Электроэнергия 
(Квт/час) 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 
Вода и канализация 
(м3) 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 
Сбытовые издержки 
(руб.) 1186,062 1180,431 1230,263 1205,406 1201,14 1192,871 1214,133 1198,972 1184,553 1194,064 
Здания и сооружения 
(руб.) 150824,6 152402,2 151031,6 149972 150384,3 151234,6 149922 142713,2 150542 152071,9 
Оборудование (руб.) 57250,71 57141,2 56279,3 54632,01 56273,57 56491,51 55946,63 56238,2 56896,26 54051,46 
Цена реализации 5 
(руб.) 86,78825 81,00815 94,73219 87,56876 73,96144 77,3873 77,3931 80,61553 83,79104 67,33077 
Цена реализации 6 
(руб.) 90,78825 85,00815 98,73219 91,56876 77,96144 81,3873 81,3931 84,61553 87,79104 71,33077 
Цена реализации 7 
(руб.) 92,78825 87,00815 100,7322 93,56876 79,96144 83,3873 83,3931 86,61553 89,79104 73,33077 
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Вариант 71 72 73 74 75 76 77 78 79 80 
Производственная 
мощность 
оборудования (шт.) 5 936 5 841 5 681 5 484 5 854 5 670 5 664 6 099 5 854 5 381 
Стоимость зданий 
(руб.) 83959,86 81561,05 88051,2 88915,87 80631,17 85377,57 88101,89 81851,74 86375,66 86772,63 
Стоимость 
оборудования (руб.) 108722,4 94044,27 81038,67 105705,2 89925,68 97194,6 83882,67 81645,83 99205,52 85264,97 
ЗП директора в месяц 
(руб.) 311,0728 362,8367 350,6876 336,3246 354,911 344,5849 355,0691 336,1823 339,3108 369,7139 
ЗП бухгалтера в месяц 
(руб.) 278,6954 239,8677 228,508 261,9329 222,2982 242,2397 238,9028 251,1048 211,3721 282,3972 
ЗП начальника цеха в 
месяц (руб.) 180,4817 192,661 188,4685 211,0954 227,7989 193,1487 198,1496 216,1194 205,8298 202,9899 

Основные рабочие  
Рабочий 4 раз (чел.) 5,102573 4,330807 4,396475 6,588442 5,348534 4,212489 5,511898 5,102726 5,959412 6,491353 
Рабочий 3 раз (чел.) 5,320219 5,471751 5,834384 4,555268 4,752195 5,750294 5,301673 4,981908 4,421889 4,357085 
Рабочий 2 раз (чел.) 5,167508 3,445733 5,986802 4,584054 1,598926 2,998048 6,567196 5,541338 6,380922 3,567009 

Вспомогательные рабочие  
Разнорабочий  
1 разряда (чел.) 2,102573 1,330807 1,396475 3,588442 2,348534 1,212489 2,511898 2,102726 2,959412 3,491353 
Сторож (чел.) 1 1 1 1 1 1 1 1 1 1 
ЗП работника  
1 разряда (руб.) 101,0257 93,30807 93,96475 115,8844 103,4853 92,12489 105,119 101,0273 109,5941 114,9135 
Металлоотходы (кг) 21,73841 24,88408 20,56688 20,87791 21,07149 24,10382 17,44743 15,56669 21,19349 21,52733 
Полистирол (кг) 508,7176 491,8529 527,965 537,8008 490,6304 480,8768 479,808 496,8939 516,132 503,2098 
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Песок (кг) 0,104511 0,114317 0,084649 0,089461 0,062588 0,098515 0,080217 0,118154 0,123702 0,096031 
Полиэтилен (кг) 0,011346 -0,01096 0,012466 0,017953 0,023239 0,024733 -0,01345 -0,00915 0,067854 -0,00252 
Паста 
противопригарная (кг) 0,000777 0,001431 0,003456 0,005672 0,000567 -0,00326 -0,00153 0,001367 -0,00171 -0,0013 
Стекло (кг) 0,009413 0,01478 0,008077 0,009003 0,007388 0,008875 0,007267 0,013427 0,008324 0,00499 
Электроэнергия 
(Квт/час) 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 
Вода и канализация 
(м3) 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 
Сбытовые издержки 
(руб.) 1193,397 1195,907 1200,538 1206,481 1213,344 1203,127 1179,798 1192,75 1193,682 1217,237 
Здания и сооружения 
(руб.) 148185,2 152431,4 152846 143179,4 150063,6 153131,3 145754 151421,7 149640,2 151842,9 
Оборудование (руб.) 54689,17 54204,47 56773,2 54387,75 56215,6 56453,77 54105,8 56785,29 56723,44 55603,44 
Цена реализации 5 
(руб.) 83,75352 77,12968 82,81026 81,15036 98,46297 106,1102 78,72556 94,18655 78,89264 87,47448 
Цена реализации 6 
(руб.) 87,75352 81,12968 86,81026 85,15036 102,463 110,1102 82,72556 98,18655 82,89264 91,47448 
Цена реализации 7 
(руб.) 89,75352 83,12968 88,81026 87,15036 104,463 112,1102 84,72556 100,1866 84,89264 93,47448 
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Вариант 81 82 83 84 85 86 87 88 89 90 
Производственная 
мощность 
оборудования (шт.) 5 753 5 617 5 847 5 759 5 736 5 601 5 433 5 501 5 643 5 903 
Стоимость зданий 
(руб.) 86927,35 86822,3 82606,79 85693,93 82953,89 86292,04 83734,22 86113,86 87444,06 84305,58 
Стоимость 
оборудования (руб.) 116488,1 137414,7 99848,18 95082,66 111593,2 120138,7 88953,7 128083,8 73307,74 116372,3 
ЗП директора в месяц 
(руб.) 378,1227 333,3228 376,7773 335,7187 334,4991 311,5666 340,3372 333,2319 345,1942 334,3156 
ЗП бухгалтера в месяц 
(руб.) 208,8982 273,8975 256,7568 212,5818 243,5205 251,8386 248,8435 287,9119 216,4057 232,3521 
ЗП начальника цеха в 
месяц (руб.) 193,0147 207,7597 209,166 209,7526 180,1587 188,9212 206,9956 226,5065 179,7153 207,973 

Основные рабочие  
Рабочий 4 раз (чел.) 6,089466 4,828068 6,963726 3,672097 4,958488 5,336286 3,563796 2,789928 3,630301 5,32441 
Рабочий 3 раз (чел.) 3,361814 5,573236 4,890349 6,900908 6,199762 4,445596 5,191843 6,302114 5,820272 5,538329 
Рабочий 2 раз (чел.) 5,904724 5,395264 4,484261 4,642755 4,24717 6,055209 5,782202 5,229938 5,757307 5,599675 

Вспомогательные рабочие  
Разнорабочий  
1 разряда (чел.) 3,089466 1,828068 3,963726 0,672097 1,958488 2,336286 0,563796 1 0,630301 2,32441 
Сторож (чел.) 1 1 1 1 1 1 1 1 1 1 
ЗП работника  
1 разряда (руб.) 110,8947 98,28068 119,6373 86,72097 99,58488 103,3629 85,63796 77,89928 86,30301 103,2441 
Металлоотходы (кг) 19,93149 25,00087 21,75553 18,83997 26,41794 15,02109 23,3128 16,77856 18,88928 19,38093 
Полистирол (кг) 463,7522 462,0883 448,6508 513,0722 525,353 506,3503 471,6572 482,0645 511,3886 514,9186 
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Песок (кг) 0,105512 0,077719 0,089445 0,074149 0,114585 0,08159 0,091336 0,087952 0,064903 0,072425 
Полиэтилен (кг) -0,01122 -0,00678 0,014888 0,008477 0,018999 0,024408 0,013658 0,000893 0,003377 0,005383 
Паста 
противопригарная (кг) 0,002323 -7,2E-05 0,003552 0,003249 0,001279 -9,8E-05 0,002849 0,000474 0,002307 0,002482 
Стекло (кг) 0,008751 0,009461 0,007865 0,008308 0,009679 0,012519 0,005962 0,009842 0,006682 0,006947 
Электроэнергия 
(Квт/час) 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 
Вода и канализация 
(м3) 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 
Сбытовые издержки 
(руб.) 1215,161 1199,755 1198,304 1203,618 1193,554 1197,695 1190,662 1201,409 1196,501 1196,799 
Здания и сооружения 
(руб.) 149288,2 150611 151896,1 155420,6 147819,5 142332,4 150003 150758,2 151948,5 151935,5 
Оборудование (руб.) 54743,79 56940,19 56251,51 54818,81 57143,52 56465,29 55253,86 56754,4 56675,85 56592,67 
Цена реализации 5 
(руб.) 96,15901 93,9778 84,41645 90,69332 80,58943 83,85024 92,7992 76,70307 75,15823 84,58932 
Цена реализации 6 
(руб.) 100,159 97,9778 88,41645 94,69332 84,58943 87,85024 96,7992 80,70307 79,15823 88,58932 
Цена реализации 7 
(руб.) 102,159 99,9778 90,41645 96,69332 86,58943 89,85024 98,7992 82,70307 81,15823 90,58932 
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Вариант 91 92 93 94 95 96 97 98 99 100 
Производственная 
мощность 
оборудования (шт.) 5 701 6 271 5 860 5 591 5 450 5 791 5 685 5 309 5 821 5 693 
Стоимость зданий 
(руб.) 85103,93 84567,24 80196,96 84641,78 85973,46 88744,4 90223,59 89073,65 86056,4 86442,78 
Стоимость 
оборудования (руб.) 89817,51 109382,1 88544,82 91681,05 129652 76570,57 97469,64 115137,4 96367,07 113338 
ЗП директора в месяц 
(руб.) 327,9096 274,2355 352,4797 338,4855 336,6808 340,434 383,5896 356,8124 335,0493 375,3354 
ЗП бухгалтера в месяц 
(руб.) 296,7976 261,3743 212,1061 237,4049 208,6825 272,269 276,5813 237,124 309,8848 213,299 
ЗП начальника цеха в 
месяц (руб.) 205,4064 207,2989 215,7244 191,4433 186,1152 200,2691 191,02 215,3593 202,5254 196,6169 

Основные рабочие  
Рабочий 4 раз (чел.) 7,131819 5,551285 4,820143 4,287787 4,832802 6,250974 3,782932 6,511903 5,574498 3,660928 
Рабочий 3 раз (чел.) 3,84506 4,217071 6,857106 6,174383 4,697686 4,918938 3,268922 5,010059 2,628183 7,163288 
Рабочий 2 раз (чел.) 6,148996 4,735514 5,07316 5,632135 5,530124 4,516847 5,346747 5,345528 6,483954 3,775679 

Вспомогательные рабочие  
Разнорабочий  
1 разряда (чел.) 4,131819 2,551285 1,820143 1,287787 1,832802 3,250974 0,782932 3,511903 2,574498 0,660928 
Сторож (чел.) 1 1 1 1 1 1 1 1 1 1 
ЗП работника  
1 разряда (руб.) 121,3182 105,5128 98,20143 92,87787 98,32802 112,5097 87,82932 115,119 105,745 86,60928 
Металлоотходы (кг) 16,39316 23,43591 14,95626 21,4984 17,78816 22,62989 16,55966 20,64136 22,34349 20,57156 
Полистирол (кг) 505,6933 515,8514 493,4794 537,0498 483,2202 480,3331 491,9358 465,3191 507,3342 496,3404 
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Песок (кг) 0,073128 0,10797 0,111691 0,084323 0,084227 0,103107 0,104459 0,101523 0,098923 0,089069 
Полиэтилен (кг) 0,014272 0,012504 -0,02465 0,008853 -0,00794 0,0438 0,030092 -0,05004 0,000106 -0,01274 
Паста 
противопригарная (кг) -0,00234 0,000644 0,000413 0,002428 -0,00085 -6,7E-05 -0,0026 0,000868 -0,00106 -0,0042 
Стекло (кг) 0,010287 0,009009 0,01136 0,004251 0,008086 0,01109 0,00873 0,013596 0,005582 0,012452 
Электроэнергия 
(Квт/час) 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 0,069767 
Вода и канализация 
(м3) 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 0,023256 
Сбытовые издержки 
(руб.) 1173,624 1188,248 1177,741 1190,679 1186,522 1177,393 1200,494 1197,038 1216,917 1209,006 
Здания и сооружения 
(руб.) 150194,4 146409,4 149312,5 150216,2 147318,2 149577,8 151899,1 153617,5 151669,8 150615,3 
Оборудование (руб.) 58045,85 56683,6 55813,91 55577,61 55090,87 56157,34 55861,11 55566,06 55432,35 55111,84 
Цена реализации 5 
(руб.) 88,05941 89,81852 86,42044 77,62754 96,25934 88,0659 90,54844 76,41274 70,29334 84,10679 
Цена реализации 6 
(руб.) 92,05941 93,81852 90,42044 81,62754 100,2593 92,0659 94,54844 80,41274 74,29334 88,10679 
Цена реализации 7 
(руб.) 94,05941 95,81852 92,42044 83,62754 102,2593 94,0659 96,54844 82,41274 76,29334 90,10679 
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